
 

Oracle® Agile Product Lifecycle Management for 
Process
Administrator User Guide  

Release 6.2 

E48697-01

April 2015



Oracle Agile Product Lifecycle Management for Process Administrator User Guide, Release 6.2 

E48697-01

Copyright © 2015, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on 
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your 
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, 
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse 
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is 
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If 
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it 
on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, 
any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users 
are "commercial computer software" pursuant to the applicable Federal Acquisition Regulation and 
agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and 
adaptation of the programs, including any operating system, integrated software, any programs installed on 
the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to 
the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management 
applications. It is not developed or intended for use in any inherently dangerous applications, including 
applications that may create a risk of personal injury. If you use this software or hardware in dangerous 
applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other 
measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages 
caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of 
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks 
are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, 
Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced 
Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, 
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly 
disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle 
Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your 
access to or use of third-party content, products, or services.



iii

Contents

Preface ...............................................................................................................................................................    xv

Audience.....................................................................................................................................................     xv
Variability of Installations........................................................................................................................     xv
Documentation Accessibility ...................................................................................................................     xv
Software Availability ................................................................................................................................    xvi
Related Documents ...................................................................................................................................    xvi
Conventions ..............................................................................................................................................    xvii

1 Introducing Administration

Administration Overview.......................................................................................................................   1-1

2 Using ADMN to Manage Core Data

Types of Core Data ...................................................................................................................................   2-1
Statuses .........................................................................................................................................   2-3
Administrative Roles..................................................................................................................   2-4
Navigating Core Data.................................................................................................................   2-4

Maintaining Simple Lists ..................................................................................................................   2-4
Searching Simple Lists ...............................................................................................................   2-6
Bulk Updating .............................................................................................................................   2-7

Maintaining Tree Lists.......................................................................................................................   2-9
Drag and Drop Feature ..............................................................................................................   2-9
Editing Actions.........................................................................................................................    2-10
Searching Tree Lists .................................................................................................................    2-13

Custom Data ...........................................................................................................................................    2-15
Category Tabs ..................................................................................................................................    2-15

Key Fields..................................................................................................................................    2-15
Editing Rules.............................................................................................................................    2-15

Custom Section Column Tags .......................................................................................................    2-16
Key Fields..................................................................................................................................    2-16
Editing Rules.............................................................................................................................    2-16

Custom Section Order ....................................................................................................................    2-17
Key Fields..................................................................................................................................    2-17
Display Filters...........................................................................................................................    2-17
Editing Rules.............................................................................................................................    2-17



iv

Custom Section Row Tags .............................................................................................................    2-18
Key Fields..................................................................................................................................    2-18
Editing Rules.............................................................................................................................    2-18

Custom Section Tab Order.............................................................................................................    2-19
Key Fields..................................................................................................................................    2-19
Editing Rules.............................................................................................................................    2-19

Custom Section Tags.......................................................................................................................    2-20
Key Fields..................................................................................................................................    2-20
Editing Rules.............................................................................................................................    2-20

Extended Attribute Groups ...........................................................................................................    2-21
Key Fields..................................................................................................................................    2-21
Editing Rules.............................................................................................................................    2-21

Extended Attribute Order..............................................................................................................    2-22
Key Fields..................................................................................................................................    2-22
Display Filters...........................................................................................................................    2-22
Editing Rules.............................................................................................................................    2-22

Extended Attribute Tab Order ......................................................................................................    2-23
Key Fields..................................................................................................................................    2-23
Editing Rules.............................................................................................................................    2-23

Extended Attribute Tags ................................................................................................................    2-24
Key Fields..................................................................................................................................    2-24
Editing Rules.............................................................................................................................    2-24

Custom Portal.........................................................................................................................................    2-25
Custom Portals ................................................................................................................................    2-25

Key Fields..................................................................................................................................    2-25
Editing Rules.............................................................................................................................    2-25

Custom Portal Views ......................................................................................................................    2-26
Key Fields..................................................................................................................................    2-26
Editing Rules.............................................................................................................................    2-26

Document Reference Library Data ....................................................................................................    2-27
Catalogs ............................................................................................................................................    2-27

Editing Rules.............................................................................................................................    2-27
Classifications ..................................................................................................................................    2-28

Editing Rules.............................................................................................................................    2-28
Global Data.............................................................................................................................................    2-29

Attachment Tags .............................................................................................................................    2-29
Key Fields..................................................................................................................................    2-29
Editing Rules.............................................................................................................................    2-29

Countries ..........................................................................................................................................    2-30
Key Fields..................................................................................................................................    2-30
Editing Rules.............................................................................................................................    2-30

Cross Reference Statuses ................................................................................................................    2-31
Key Fields..................................................................................................................................    2-31
Editing Rules.............................................................................................................................    2-31

Reordering Cross Reference Statuses ............................................................................    2-31



v

Cross References..............................................................................................................................    2-32
Key Fields..................................................................................................................................    2-32
Editing Rules.............................................................................................................................    2-32

Data Groups.....................................................................................................................................    2-33
Key Field....................................................................................................................................    2-33
Editing Rules.............................................................................................................................    2-33

Document Tags................................................................................................................................    2-34
Key Fields..................................................................................................................................    2-34
Editing Rules.............................................................................................................................    2-34

Restrictions.......................................................................................................................................    2-35
Editing Rules.............................................................................................................................    2-35

Segments...........................................................................................................................................    2-36
Editing Rules.............................................................................................................................    2-36

States/Provinces..............................................................................................................................    2-37
Key Fields..................................................................................................................................    2-37
Editing Rules.............................................................................................................................    2-37

Substitute Restrictions ....................................................................................................................    2-38
Key Fields..................................................................................................................................    2-38
Editing Rules.............................................................................................................................    2-38

Reordering Substitute Restrictions.................................................................................    2-38
UOM..................................................................................................................................................    2-39

Key Fields..................................................................................................................................    2-39
Editing Rules.............................................................................................................................    2-40

Reordering UOMs.............................................................................................................    2-40
Global Specification Management Common Data.........................................................................    2-41

Brands - (GSM Legacy Free Text) .................................................................................................    2-41
Key Fields..................................................................................................................................    2-41
Editing Rules.............................................................................................................................    2-41

Brands - (GSM) ................................................................................................................................    2-42
Key Fields..................................................................................................................................    2-42
Editing Rules.............................................................................................................................    2-42

Business Units - (GSM)...................................................................................................................    2-43
Editing Rules.............................................................................................................................    2-43

Classification....................................................................................................................................    2-44
Key Fields..................................................................................................................................    2-44
Editing Rules.............................................................................................................................    2-44

Concepts ...........................................................................................................................................    2-45
Editing Rules.............................................................................................................................    2-45

Document Status .............................................................................................................................    2-46
Key Fields..................................................................................................................................    2-46
Editing Rules.............................................................................................................................    2-46

Document Type ...............................................................................................................................    2-47
Key Fields..................................................................................................................................    2-47
Editing Rules.............................................................................................................................    2-47

Environmental Waste .....................................................................................................................    2-48
Key Fields..................................................................................................................................    2-48
Editing Rules.............................................................................................................................    2-48



vi

Formulation Classification.............................................................................................................    2-49
Key Fields..................................................................................................................................    2-49
Editing Rules.............................................................................................................................    2-49

Formulation Item Type...................................................................................................................    2-50
Key Fields..................................................................................................................................    2-50
Editing Rules.............................................................................................................................    2-50

Formulation Tags ............................................................................................................................    2-51
Key Fields..................................................................................................................................    2-51
Editing Rules.............................................................................................................................    2-51

Formula Output Types - External.................................................................................................    2-52
Key Fields..................................................................................................................................    2-52
Editing Rules.............................................................................................................................    2-52

Formula Output Types - Internal..................................................................................................    2-53
Key Fields..................................................................................................................................    2-53
Editing Rules.............................................................................................................................    2-53

Formula Output Types - Referenced............................................................................................    2-54
Key Fields..................................................................................................................................    2-54
Editing Rules.............................................................................................................................    2-54

Label Claims.....................................................................................................................................    2-55
Key Fields..................................................................................................................................    2-55
Editing Rules.............................................................................................................................    2-55

Label Claims Classifications ..........................................................................................................    2-56
Key Fields..................................................................................................................................    2-56
Editing Rules.............................................................................................................................    2-56

Label Owner.....................................................................................................................................    2-57
Key Fields..................................................................................................................................    2-57
Editing Rules.............................................................................................................................    2-57

Menu Item Class..............................................................................................................................    2-58
Key Field....................................................................................................................................    2-58
Editing Rules.............................................................................................................................    2-58

Menu Item Standard.......................................................................................................................    2-59
Key Fields..................................................................................................................................    2-59
Editing Rules.............................................................................................................................    2-59

Nutp Special Attributes..................................................................................................................    2-60
Key Fields..................................................................................................................................    2-60
Editing Rules.............................................................................................................................    2-60

Nutrient Source ...............................................................................................................................    2-61
Key Fields..................................................................................................................................    2-61
Editing Rules.............................................................................................................................    2-61

Reordering Nutrient Sources ..........................................................................................    2-61
Packaging Type ...............................................................................................................................    2-62

Key Fields..................................................................................................................................    2-62
Editing Rules.............................................................................................................................    2-62

Packaging Item Type ......................................................................................................................    2-63
Key Fields..................................................................................................................................    2-63
Editing Rules.............................................................................................................................    2-63



vii

Printed Packaging Languages.......................................................................................................    2-64
Key Fields..................................................................................................................................    2-64
Editing Rules.............................................................................................................................    2-64

Raw Material Types ........................................................................................................................    2-65
Key Fields..................................................................................................................................    2-65
Editing Rules.............................................................................................................................    2-65

Shelf Life Type .................................................................................................................................    2-66
Key Fields..................................................................................................................................    2-66
Editing Rules.............................................................................................................................    2-66

Reordering Shelf Life Types............................................................................................    2-66
Smart Issue Status ...........................................................................................................................    2-67

Key Fields..................................................................................................................................    2-67
Editing Rules.............................................................................................................................    2-67

Reordering Smart Issue Status........................................................................................    2-67
Storage and Shipping Requirements............................................................................................    2-68

Key Fields..................................................................................................................................    2-68
Editing Rules.............................................................................................................................    2-68

Storage Requirements (Trade Specs)............................................................................................    2-69
Key Fields..................................................................................................................................    2-69
Editing Rules.............................................................................................................................    2-69

Substitute Material Tags.................................................................................................................    2-70
Key Fields..................................................................................................................................    2-70
Editing Rules.............................................................................................................................    2-70

Reordering Substitute Material Tags .............................................................................    2-70
Trade Item Type ..............................................................................................................................    2-71

Key Fields..................................................................................................................................    2-71
Editing Rules.............................................................................................................................    2-72

Trade Tax Type/Rate .....................................................................................................................    2-73
Key Fields..................................................................................................................................    2-73
Editing Rules.............................................................................................................................    2-73

Trade UNSPSC Code ......................................................................................................................    2-74
Editing Rules.............................................................................................................................    2-74

Trading Company...........................................................................................................................    2-75
Key Fields..................................................................................................................................    2-75
Editing Rules.............................................................................................................................    2-75

UDEX Classifications......................................................................................................................    2-76
Editing Rules.............................................................................................................................    2-76

Global Specification Management Compliance Data....................................................................    2-77
Additives ..........................................................................................................................................    2-77

Key Fields..................................................................................................................................    2-77
Editing Rules.............................................................................................................................    2-77

Allergens...........................................................................................................................................    2-78
Key Fields..................................................................................................................................    2-78
Editing Rules.............................................................................................................................    2-78

Complies With .................................................................................................................................    2-79
Key Fields..................................................................................................................................    2-79
Editing Rules.............................................................................................................................    2-79



viii

Intolerances ......................................................................................................................................    2-80
Key Fields..................................................................................................................................    2-80
Editing Rules.............................................................................................................................    2-80

Global Specification Management FSIS Data .................................................................................    2-81
Application Status...........................................................................................................................    2-81

Key Fields..................................................................................................................................    2-81
Editing Rules.............................................................................................................................    2-81

Reordering Application Statuses....................................................................................    2-81
CFIA Approval Type ......................................................................................................................    2-82

Key Fields..................................................................................................................................    2-82
Editing Rules.............................................................................................................................    2-82

Reordering CFIA Approval Types .................................................................................    2-82
CFIA Payment Method ..................................................................................................................    2-83

Key Fields..................................................................................................................................    2-83
Editing Rules.............................................................................................................................    2-83

Reordering CFIA Payment Methods .............................................................................    2-83
CFIA Product Type .........................................................................................................................    2-84

Key Fields..................................................................................................................................    2-84
Editing Rules.............................................................................................................................    2-84

Reordering CFIA Product Types ....................................................................................    2-84
USDA HACCP Category ...............................................................................................................    2-85

Key Fields..................................................................................................................................    2-85
Editing Rules.............................................................................................................................    2-85

Reordering USDA HACCP Categories .........................................................................    2-85
New Product Development Data .......................................................................................................    2-86

Brands - (NPD) ................................................................................................................................    2-86
Key Fields..................................................................................................................................    2-86
Editing Rules.............................................................................................................................    2-86

Business Units - (NPD)...................................................................................................................    2-87
Editing Rules.............................................................................................................................    2-87

Channels ...........................................................................................................................................    2-88
Key Fields..................................................................................................................................    2-88
Editing Rules.............................................................................................................................    2-88

Consumer Value Perception..........................................................................................................    2-89
Key Fields..................................................................................................................................    2-89
Editing Rules.............................................................................................................................    2-89

Demographic Categories................................................................................................................    2-90
Key Fields..................................................................................................................................    2-90
Editing Rules.............................................................................................................................    2-90

Document Status .............................................................................................................................    2-91
Key Fields..................................................................................................................................    2-91
Editing Rules.............................................................................................................................    2-91

Document Type ...............................................................................................................................    2-92
Key Fields..................................................................................................................................    2-92
Editing Rules.............................................................................................................................    2-92



ix

Enabling Technology ......................................................................................................................    2-93
Key Fields..................................................................................................................................    2-93
Editing Rules.............................................................................................................................    2-93

Functional Area - (NPD) ................................................................................................................    2-94
Key Fields..................................................................................................................................    2-94
Editing Rules.............................................................................................................................    2-94

Global Categories ............................................................................................................................    2-95
Key Fields..................................................................................................................................    2-95
Editing Rules.............................................................................................................................    2-95

Metrics - Basis ..................................................................................................................................    2-96
Key Fields..................................................................................................................................    2-96
Editing Rules.............................................................................................................................    2-96

Metrics - Category...........................................................................................................................    2-97
Key Fields..................................................................................................................................    2-97
Editing Rules.............................................................................................................................    2-97

Metrics - Fiscal Year ........................................................................................................................    2-98
Key Fields..................................................................................................................................    2-98
Editing Rules.............................................................................................................................    2-98

Metrics - Phase.................................................................................................................................    2-99
Key Fields..................................................................................................................................    2-99
Editing Rules.............................................................................................................................    2-99

Priorities..........................................................................................................................................    2-100
Key Fields................................................................................................................................    2-100
Editing Rules...........................................................................................................................    2-100

Project Type Categories................................................................................................................    2-101
Editing Rules...........................................................................................................................    2-101

Project Types..................................................................................................................................    2-102
Key Fields................................................................................................................................    2-102
Editing Rules...........................................................................................................................    2-102

Project Visibilities..........................................................................................................................    2-103
Key Fields................................................................................................................................    2-103
Editing Rules...........................................................................................................................    2-103

Risk..................................................................................................................................................    2-104
Key Fields................................................................................................................................    2-104
Editing Rules...........................................................................................................................    2-104

Product Quality Management Data .................................................................................................    2-105
Action Type....................................................................................................................................    2-105

Key Fields................................................................................................................................    2-105
Editing Rules...........................................................................................................................    2-105

Audit Result ...................................................................................................................................    2-106
Key Fields................................................................................................................................    2-106
Editing Rules...........................................................................................................................    2-106

Audit Type .....................................................................................................................................    2-107
Key Fields................................................................................................................................    2-107
Editing Rules...........................................................................................................................    2-107



x

Customers.......................................................................................................................................    2-108
Key Fields................................................................................................................................    2-108
Editing Rules...........................................................................................................................    2-108

Document Status ...........................................................................................................................    2-109
Key Fields................................................................................................................................    2-109
Editing Rules...........................................................................................................................    2-109

Document Type .............................................................................................................................    2-110
Key Fields................................................................................................................................    2-110
Editing Rules...........................................................................................................................    2-110

Failure Type ...................................................................................................................................    2-111
Key Fields................................................................................................................................    2-111
Editing Rules...........................................................................................................................    2-111

Issue Types.....................................................................................................................................    2-112
Key Fields................................................................................................................................    2-112
Editing Rules...........................................................................................................................    2-112

Product Line...................................................................................................................................    2-113
Key Fields................................................................................................................................    2-113
Editing Rules...........................................................................................................................    2-113

Resolution.......................................................................................................................................    2-114
Key Fields................................................................................................................................    2-114
Editing Rules...........................................................................................................................    2-114

Severity ...........................................................................................................................................    2-115
Key Fields................................................................................................................................    2-115
Editing Rules...........................................................................................................................    2-115

Product Quality Scorecard Data .......................................................................................................    2-116
Lot Samples Quantity UOMs ......................................................................................................    2-116

Key Fields................................................................................................................................    2-116
Editing Rules...........................................................................................................................    2-116

Reordering Lot Samples Quantity UOMs...................................................................    2-116
Sample Types.................................................................................................................................    2-117

Key Fields................................................................................................................................    2-117
Editing Rules...........................................................................................................................    2-117

Scorecard Qualifications ..............................................................................................................    2-118
Key Fields................................................................................................................................    2-118
Editing Rules...........................................................................................................................    2-118

Reordering Scorecard Qualifications ...........................................................................    2-118
Supply Chain Relationship Management Data ............................................................................    2-119

Business Units - (SCRM) ..............................................................................................................    2-119
Editing Rules...........................................................................................................................    2-119

Class ................................................................................................................................................    2-120
Key Field..................................................................................................................................    2-120
Editing Rules...........................................................................................................................    2-120

Reordering Classes .........................................................................................................    2-120
Company Special Attributes........................................................................................................    2-121

Key Field..................................................................................................................................    2-121
Editing Rules...........................................................................................................................    2-121



xi

Contact Category...........................................................................................................................    2-122
Key Field..................................................................................................................................    2-122
Editing Rules...........................................................................................................................    2-122

Contact Profile Tags......................................................................................................................    2-123
Key Fields................................................................................................................................    2-123
Editing Rules...........................................................................................................................    2-123

Document Status ...........................................................................................................................    2-124
Key Fields................................................................................................................................    2-124
Editing Rules...........................................................................................................................    2-124

Document Type .............................................................................................................................    2-125
Key Fields................................................................................................................................    2-125
Editing Rules...........................................................................................................................    2-125

Facility Special Attributes ............................................................................................................    2-126
Key Fields................................................................................................................................    2-126
Editing Rules...........................................................................................................................    2-126

Protocol ...........................................................................................................................................    2-127
Key Field..................................................................................................................................    2-127
Editing Rules...........................................................................................................................    2-127

Sourcing Type................................................................................................................................    2-128
Key Field..................................................................................................................................    2-128
Editing Rules...........................................................................................................................    2-128

Workflow Administration Data........................................................................................................    2-129
Functional Area - (WFA)..............................................................................................................    2-129

Key Field..................................................................................................................................    2-129
Editing Rules...........................................................................................................................    2-129

Tags .................................................................................................................................................    2-130
Key Fields................................................................................................................................    2-130
Editing Rules...........................................................................................................................    2-131

Spec Category.......................................................................................................................................    2-132
Node Statuses ................................................................................................................................    2-132
Editing Specification Categories .................................................................................................    2-132
Parent-Child Relationship Guidelines .......................................................................................    2-133

Activities ...............................................................................................................................................    2-134
Generate Token..............................................................................................................................    2-134
Export..............................................................................................................................................    2-135

Token Section..........................................................................................................................    2-135
Export Data Section ...............................................................................................................    2-136

Import .............................................................................................................................................    2-136
Initiate Import Section...........................................................................................................    2-137
Import Queue Section............................................................................................................    2-137



xii

3 Using ADMN to Manage Custom Data

Introducing Custom Data .......................................................................................................................   3-1
Custom Data Types............................................................................................................................   3-1

Statuses .........................................................................................................................................   3-2
Administrative Roles...........................................................................................................   3-2

Extended Attribute Groups ....................................................................................................................   3-3
Creating or Editing Extended Attribute Groups ................................................................................   3-4
Extended Attributes .................................................................................................................................   3-5

Summary Tab ..............................................................................................................................   3-6
Attribute Configuration Section ........................................................................................   3-6
Type .......................................................................................................................................   3-8
Date ........................................................................................................................................   3-8
Free Text ................................................................................................................................   3-9
Long Free Text......................................................................................................................   3-9
Long Multi-lingual Text...................................................................................................    3-10
Multi-lingual Text .............................................................................................................    3-11
Numeric..............................................................................................................................    3-12
Quantitative Range...........................................................................................................    3-13
Quantitative Tolerance.....................................................................................................    3-14
Qualitative .........................................................................................................................    3-15
Qualitative Lookup...........................................................................................................    3-18
Calculated Boolean ...........................................................................................................    3-21
Calculated Numeric..........................................................................................................    3-23
Calculated Text..................................................................................................................    3-24
Boolean ...............................................................................................................................    3-25

Creating an Extended Attribute..........................................................................................................    3-27
Displaying Extended Attributes as Bold or Italic Text ..............................................................    3-27
Editing an Extended Attribute ......................................................................................................    3-28
Searching for Extended Attributes ...............................................................................................    3-29
Setting Extended Attribute Order.................................................................................................    3-30

Custom Sections ....................................................................................................................................    3-33
Summary Section .....................................................................................................................    3-35
De-normalization Process Section .........................................................................................    3-37

Creating a Custom Section ..................................................................................................................    3-39
Creating a Table...............................................................................................................................    3-41

Creating Columns ....................................................................................................................    3-41
Defining the Row Header Column........................................................................................    3-42
Defining Additional Columns ...............................................................................................    3-43
Creating Rows ..........................................................................................................................    3-45
Defining Additional Rows......................................................................................................    3-45
Defining Cells ...........................................................................................................................    3-47
Copying Rows ..........................................................................................................................    3-47
Reordering Columns ...............................................................................................................    3-48
Reordering Rows......................................................................................................................    3-49

Legend................................................................................................................................    3-50
Formatting Custom Sections ..................................................................................................    3-50

Hide Row Header .............................................................................................................    3-50



xiii

Hide Custom Section Header .........................................................................................    3-51
Re-using a Custom Section Row Template .................................................................................    3-52

Use Case Example....................................................................................................................    3-52
The Solution..............................................................................................................................    3-53

Previewing a Custom Section........................................................................................................    3-54
Calculating Extended Attributes ...........................................................................................    3-54

Editing Custom Sections ................................................................................................................    3-55
Copying a Custom Section.............................................................................................................    3-55
Searching for Custom Sections......................................................................................................    3-57

Setting Custom Section Order ............................................................................................................    3-58

4 Using CACHE to Manage Caches

Scheduling Data Cache Flushes ............................................................................................................   4-1
Workflow Groups and Workflows..................................................................................................   4-1
Data Administration ..........................................................................................................................   4-2

Using the Cache Application .................................................................................................................   4-3
Scheduled Cache Flush Queue.........................................................................................................   4-4

5 Using Performance Logging

Overview ....................................................................................................................................................   5-1
Enabling Performance Logging .............................................................................................................   5-1
Performance Log File ...............................................................................................................................   5-2
Performance Analysis..............................................................................................................................   5-2

Logging the Action ............................................................................................................................   5-2
Interpreting the Data .........................................................................................................................   5-3
Finding SQL Performance Issues.....................................................................................................   5-3
User Interface and Field Definitions................................................................................................   5-4

A InFoods IDs and ISO Codes

InFoods IDs ..............................................................................................................................................    A-1
ISO Codes .................................................................................................................................................    A-4



xiv



xv

Preface

The Agile Product Lifecycle Management for Process Administrator User Guide contains 
instructions for administering Agile Product Lifecycle Management (PLM) for Process.

This preface contains these topics:

■ Audience

■ Variability of Installations

■ Documentation Accessibility

■ Software Availability

■ Related Documents

■ Conventions

Audience
This user guide is intended for Agile PLM for Process administrators, including user 
administrators, group administrators, and data administrators.

Variability of Installations
Descriptions and illustrations of the Agile PLM for Process user interface included in 
this manual may not match your installation. The user interface of Agile PLM for 
Process applications and the features included can vary greatly depending on such 
variables as:

■ Which applications your organization has purchased and installed

■ Configuration settings that may turn features off or on

■ Customization specific to your organization

■ Security settings as they apply to the system and your user account

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
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visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Software Availability
Oracle Software Delivery Cloud (OSDC) provides the latest copy of the core software. 
Note the core software does not include all patches and hot fixes. Access OSDC at:

http://edelivery.oracle.com.

Related Documents
For more information, see the following documents in the Agile PLM for Process 
documentation set: 

■ Agile Product Lifecycle Management for Process User Group Management User Guide

■ Agile Product Lifecycle Management for Process Workflow Administration User Guide

■ Agile Product Lifecycle Management for Process Global Specification Management User 
Guide

■ Agile Product Lifecycle Management for Process Supply Chain Relationship Management 
User Guide

■ Agile Product Lifecycle Management for Process eQuestionnaire User Guide

■ Agile Product Lifecycle Management for Process Document Reference Library User Guide

■ Agile Product Lifecycle Management for Process Content Synchronization and 
Syndication User Guide

■ Agile Product Lifecycle Management for Process Supplier Portal User Guide

■ Agile Product Lifecycle Management for Process New Product Development User Guide

■ Agile Product Lifecycle Management for Process Product Quality Management User 
Guide

■ Agile Product Lifecycle Management for Process Extensibility Guide

■ Agile Product Lifecycle Management for Process Security Configuration Guide

■ Agile Product Lifecycle Management for Process Release Notes. Up-to-date Release 
Notes and other documentation are posted on Oracle Technology Network (OTN) 
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http://www.oracle.com/technetwork/documentation/agile-085940.html#plmpro
cess

http://www.oracle.com/technology/documentation
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1Introducing Administration

This chapter introduces the key responsibilities of an Agile Product Lifecycle 
Management for Process administrator. This chapter includes the following topic:

■ Administration Overview

Administration Overview
As an Agile PLM for Process administrator, you can perform the following duties:

Data management—Involves use of the Manage Core Data (ADMN) application to 
manage core data. In managing data, you maintain data lists and data. For details, see 
Chapter 2, "Using ADMN to Manage Core Data" and Chapter 3, "Using ADMN to 
Manage Custom Data".

Workflow management—Involves use of the Workflow Administration (WFA) 
application in Agile PLM for Process. In managing workflows, you create and edit 
workflow process templates. This task involves creating workflow statuses, 
transitions, owners, signature requests, and notifications. For details, see the Agile 
Product Lifecycle Management for Process Workflow Administration User Guide.

Cache management—Involves use of the Manage Data Caches (CACHE) application 
to manage data caches. In managing caches, you schedule cache flushes for various 
cache groups. For details, see Chapter 4, "Using CACHE to Manage Caches".

Security management—Involves use of object level security (OLS) to control access to 
securable objects within specifications and questionnaires. You can also control 
business unit security (GSM and SCRM). For details, see the Agile Product Lifecycle 
Management for Process Security Configuration Guide.

Performance logging—Involves use of Performance Logging to troubleshoot 
performance issues. You can view detailed performance information about activities 
performed on the system, as described in Chapter 5, "Using Performance Logging". 

For general information on using Agile PLM for Process software, see the Agile Product 
Lifecycle Management for Process Getting Started Guide. 
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2Using ADMN to Manage Core Data

This chapter introduces the Manage Core Data (ADMN) application and explains how 
to maintain Agile Product Lifecycle Management for Process core data. Topics in this 
chapter include: 

■ Types of Core Data

■ Custom Data

■ Custom Portal

■ Global Data

■ Global Specification Management Common Data

■ Global Specification Management Compliance Data

■ Global Specification Management FSIS Data

■ New Product Development Data

■ Product Quality Management Data

■ Product Quality Scorecard Data

■ Supply Chain Relationship Management Data

■ Workflow Administration Data

■ Spec Category

■ Activities

Types of Core Data
Agile PLM for Process administrators use the Manage Core Data (ADMN) application 
to maintain core data. The types of core data that you maintain include:

Custom data:

■ Category tabs ■ Custom sections 
(described in "Custom 
Sections" on page 3-33)

■ Custom section column 
tags

■ Custom section order ■ Custom section row 
tags

■ Custom section tab 
order

■ Custom section tags ■ Extended attributes 
(described in "Extended 
Attributes" on page 3-5)

■ Extended attribute 
groups
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Custom Portal: Custom portals and custom portal views

DRL (Document Reference Library) data: Catalogs and classifications

Global data:

GSM (Global Specification Management) Common data:

GSM Compliance data:

GSM FSIS data:

■ Extended attribute 
order 

■ Extended attribute tab 
order

■ Extended attribute tags 

■ Attachment tags ■ Countries ■ Cross-reference statuses

■ Cross references ■ Data groups ■ Document tags

■ Restrictions ■ Segments ■ States/Provinces

■ Substitute restrictions ■ Units of measure

■ Brands (free text for 
legacy trade and 
packaging 
specifications)

■ Brands (GSM) ■ Business units (GSM) 

■ Classifications ■ Concepts ■ Document statuses

■ Document types ■ Environmental waste ■ Formulation 
classifications

■ Formulation item types ■ Formulation tags ■ Formula output types - 
external

■ Formula output types - 
internal

■ Formula output types - 
referenced

■ Label claims 

■ Label claims 
classifications

■ Label owners ■ Menu item classes

■ Menu item standards ■ Nutrient profile special 
attributes

■ Nutrient sources

■ Packaging types ■ Packaging item types ■ Raw material types

■ Printed packaging 
languages

■ Shelf life types ■ Smart issue status

■ Storage and shipping 
requirements

■ Storage requirements 
(trade specifications)

■ Substitute material tags

■ Trade item types ■ Trade tax types/rates ■ Trade UNSPSC codes

■ Trading Company ■ UDEX Classification

■ Additives ■ Allergens ■ Complies with

■ Intolerances

■ Application statuses ■ CFIA approval types ■ CFIA payment methods

■ CFIA product types ■ USDA HACCP 
categories
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NPD (New Product Development) data:

PQM (Product Quality Management) data:

PQS (Product Quality Scorecard) data:

SCRM (Supply Chain Relationship Management) data:

Specification Categories 

WFA (Workflow Administration)   data:   Functional areas (WFA) and tags

Statuses
Many types of core data contain statuses that are defined as follows:

■ New—The data is not yet ready to become available to Agile PLM for Process 
applications. When an item has a status of "new," its values remain editable.

■ Active—The data is ready to become available (searchable and consumable) for 
use in Agile PLM for Process applications.

■ Inactive—The data should no longer be used. All existing references to this item 
remain. The item is no longer available for assignment but is still searchable.

■ Archive—The item is no longer available for searching or assignment. All existing 
references to this item remain. 

■ System—Used by the system. This item cannot be edited or removed.

■ Brands (NPD) ■ Business units (NPD) ■ Channels

■ Consumer value 
perceptions

■ Demographic 
categories

■ Document statuses

■ Document types ■ Enabling technologies ■ Functional areas (NPD)

■ Global categories ■ Metrics (basis, category, 
fiscal year, and phase)

■ Priorities

■ Project type categories ■ Project types ■ Project visibilities

■ Risks

■ Action types ■ Audit results ■ Audit types

■ Customers ■ Document statuses ■ Document types

■ Failure types ■ Issue types ■ Product lines

■ Resolutions ■ Severities ■

■ Lot samples quantity 
units of measure

■ Sample types ■ Scorecard qualifications

■ Business units (SCRM) ■ Classes ■ Company special 
attributes

■ Contact categories ■ Contact profile tags ■ Document statuses 

■ Document types ■ Facility special 
attributes 

■ Protocols

■ Sourcing types

Note: For the managing data using the Data submenu, refer to 
Chapter 3, "Using ADMN to Manage Custom Data". 
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Administrative Roles
There are two user roles associated with ADMN: 

[DATA_ADMIN] —Users with the role of [DATA_ADMIN] can add new items, but 
Data Administrators can only edit the status of an item once the item has been 
activated.

[SUPER_DATA_ADMIN] —Users with the role of [SUPER_DATA_ADMIN] can edit 
items regardless of the item’s status. This role should be used with caution.

Navigating Core Data
Within ADMN, you can navigate core data using the Manage option in the action 
menu. 

Figure 2–1 Manage option

Maintaining Simple Lists
Simple lists consist of tables that contain the core data. Some tables contain multiple 
columns, which may include linked column headings. To re-sort data, click any linked 
column head and the data re-displays sorted on that column. Click any column head a 
second time to reverse the sort order based on that column. Figure 2–2 shows a simple 
list.
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Figure 2–2 Sample simple list of core data

To maintain data in a simple list:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. A table containing information is displayed. Depending on your 
assigned user role, you can add, edit, or reorder core data as described below.

To add data to a simple list:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. A table containing information is displayed.

2. Click Add from the action menu, or select the add action icon.

3. Enter the fields as described on the following pages.

4. If applicable, using the Status drop-down list, set the status for the data.

5. Click the apply changes icon to apply your changes.

6. Click Save to save your work.

7. Flush the administrator data cache group, as described in "Using the Cache 
Application" on page 4-3.

To edit a simple list:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. A table containing information is displayed.

2. Click the edit icon to the left of the row to edit. 

3. Enter your changes. 

4. Click the apply changes icon to apply your changes.

5. Click Save to save your work.

6. Flush the administrator data cache group, as described in "Using the Cache 
Application" on page 4-3.

Note: What you are allowed to edit depends on your user role as 
well as the status of the item. These rules are described in"Statuses" on 
page 2-3 and "Administrative Roles" on page 2-4. 

Click the column name to sort the 
list by that column



Types of Core Data

2-6 Agile Product Lifecycle Management for Process Administrator User Guide

To reorder data in a simple list:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. A table containing information is displayed.

2. Click Reorder. Agile PLM for Process displays a dialog box containing the items in 
the list, as Figure 2–3 shows:

Figure 2–3 Reorder dialog box

3. Select a list item, and then click Move Up and Move Down to set the preferred 
order. 

4. Repeat as necessary to set the list order.

5. Click Done.

6. Click Save to save your work. 

7. Flush the administrator data cache group, as described in "Using the Cache 
Application" on page 4-3.

Searching Simple Lists 
Use the search feature to look for an attribute in a simple list. The search bar contains 
multiple options allowing you to perform a logical search. 

The identity string field allows you to search for any string found in columns. This 
search includes all identity columns. For example, if the list contains a Name and ID 
column, the system searches both columns. You can find items based on status or data 
group filters by using the Display Filters search. Once submitted only matching items 
are shown in the list. All lists are paginated but the search still searches across all 
pages. 

Note: Only users with the role [SUPER_DATA_ADMIN] can reorder 
lists.
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Figure 2–4 Search bar

To search a simple list:

1. Enter a name in the Search for field.

2. Select an option from the Display Filters drop-down (optional).

3. Click the search icon to display a dialog box containing available filters, such as 
status.

4. Select a filter and then click Done. The dialog box closes and your selection 
displays in the filters field.

5. Click Submit. Matching results are displayed.

Bulk Updating
Users with the role of [SUPER_ADMIN} can update multiple items at once in simple 
lists using bulk update. Bulk Update allows you to quickly change things like status or 
filters on multiple items at once. 

■ Status (Active, Inactive, Archive)

■ Available In

■ Type

■ Is Distinct

■ Any filters applied to the list

Figure 2–5 Bulk Update

To perform a bulk update in simple lists:

1. Select items by clicking the corresponding checkbox. 

2. Click Bulk Update. A dialog box lists all fields available for bulk update. 
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Figure 2–6 Example of available bulk update choices

3. Select the attribute to change, then click Apply Changes. 

4. Click Save to save the changes, or Cancel to exit without saving your changes.

When combined with the admin list search tool you can quickly update multiple items 
at once. For example, lets say you want to archive all "Milk" related North American 
Allergens. You would do the following:

1. Using the search tool find all items that contain the string "Milk" and the display 
filter of "North America". 

2. You would then select all items using the select all checkbox in the first column 
header and select Bulk Update. 

When using Bulk Update in a tree list, you can quickly select all nodes below a parent 
by using the right click menu (shown in Figure 2–10 on page 2-10) and choosing Select 
All. This action selects all nodes below the parent even though the node is not 
expanded. To remove selections select Deselect All. You can use this feature to quickly 
select the nodes you would like to bulk update.

To perform a bulk update in a tree list:

1. Select items by clicking the corresponding checkbox.or using the right click menu.

2. Click Bulk Update.

Figure 2–7 Example of available bulk update choices

3. Select the attribute to change, then click Apply Changes. 

4. Click Save to save the changes, or Cancel to exit without saving your changes.
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Maintaining Tree Lists
Tree lists present core data in a hierarchal view. This view enables you to see the 
structure of the core data, including parent and child relationships, as Figure 2–8 
shows. Click the Expand and Collapse icons in the action menu to customize your 
view.

Figure 2–8 Core data in tree lists

Each piece of data is represented by a node. Click the expand node icon to view child 
nodes. Click the collapse node icon to collapse the node. 

All nodes contain an icon indicating their status:

■ ( )—Active item

■ ( )—New item

■ ( )—Inactive item

■ ( )—Archived item

Drag and Drop Feature
Only users with the role of [SUPER_DATA_ADMIN] are allowed to move nodes that 
have been activated. Users with the role of [DATA_ADMIN] can only move nodes 
with a "New" status.
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Figure 2–9 Dragging a node

Editing Actions
You can view available actions by right-clicking on a node, as Figure 2–10 shows. 

Figure 2–10 Sample tree list of core data, right-click menu for users with the role of 
[SUPER_DATA_ADMIN] 
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To add a root node:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays the tree list for the core data you 
selected.

2. Select Add from the action menu. A dialog box displays, as Figure 2–11 shows.

Figure 2–11 Add root node dialog box

3. You can move nodes by editing the Parent field. Only users with the role {SUPER_
ADMIN] can click the search icon and select a node as parent. This field is read 
only for other users. Click the clear icon to remove the chosen parent and move the 
node to the root position. Moving a node to the root position is only supported in 
tree lists that have no level restrictions like business unit as opposed to 
specification category which requires 3 levels of nodes at all times.

4. Enter a name for the item (required) in the Name field.

5. Enter an external ID in the External ID field.

6. Enter an alias for the item (required) in the Alias field. This can be an abbreviation; 
for example, "NA" for North America. You can also auto generate this alias by 
clicking Generate Alias.

7. Click Save to add the item. The page refreshes and the new root node is added to 
the list in alphabetical order. The new node icon displays next to the node. 

8. Right-click on the new node to display the submenu.

9. Click Make Active.

10. Click Save.

11. Flush the taxonomy cache option, as described in "Using the Cache Application" 
on page 4-3.

To add a child node:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays the tree list for the core data you 
selected.
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2. Expand or collapse nodes as needed to determine the location of the new node.

3. Right-click on the node that you are adding a child to. Agile PLM for Process 
displays a submenu with available choices.

4. Click Add Node. A dialog box displays.

5. Enter a name for the item (required) in the Name field.

6. Enter an external ID in the External ID field.

7. Enter an alias for the item (required) in the Alias field. This can be an abbreviation; 
for example, "NA" for North America. You can also auto generate this alias by 
clicking Generate Alias.

8. Click Save to add the item. The page refreshes and the new node is added, as 
indicated by the new node icon.

9. Right-click on the new node to display the submenu.

10. Click Make Active.

11. Click Save.

To edit a node:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays a tree list for editing purposes. 

2. Right-click on the node to edit. Agile PLM for Process displays a submenu with 
available choices.

3. Click Edit Node. A dialog box displays current node properties.

4. Make needed changes to the Name, External ID, and Alias fields.

5. Click Save.

6. Flush the taxonomy cache option, as described in "Using the Cache Application" 
on page 4-3.

To make a node active:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays a tree list for editing purposes. 

2. Right-click on the node to edit. Agile PLM for Process displays a submenu with 
available choices.

3. Click Make Active. The page refreshes and the node displays in active status, as 
indicated by the active node icon. 

4. Click Save.

5. Flush the taxonomy cache option, as described in "Using the Cache Application" 
on page 4-3.

To make a node inactive:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays a tree list for editing purposes. 

Note: Users with the role of [SUPER_DATA_ADMIN] can edit a 
node. The node must have a status of "New."
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2. Right-click on the node to edit. Agile PLM for Process displays the submenu with 
available choices.

3. Click Make Inactive. The page refreshes and the node is inactivated, as indicated 
by the inactive node icon.

4. Click Save.

5. Flush the taxonomy cache option, as described in "Using the Cache Application" 
on page 4-3.

To archive a node:

1. From the left navigation panel, select ADMN > {name of menu} > {name of 
submenu}. Agile PLM for Process displays a tree list for editing purposes. 

2. Right-click on the node to edit. Agile PLM for Process displays a submenu with 
available choices.

3. Click Mark as Archived. The page refreshes and the node is archived, as indicated 
by the archived node icon. 

4. Click Save.

5. Flush the taxonomy cache option, as described in "Using the Cache Application" 
on page 4-3.

Searching Tree Lists 
Use the search feature to look for an attribute in a tree list. When you click Search, all 
levels of nodes are searched. 

To search a tree list:

1. Enter a name in the Search for field.

2. Select an operator in the operator drop down list. Options are And and Or.

3. Select a filter in the Display Filters drop down list. Options are Contains One and 
Contains All. 

4. Click Search. 

Matching results are displayed.

Bulk Updating

Users with the role of [SUPER_ADMIN} can update multiple items at once in tree lists 
using bulk update. On lists where bulk update is available, a Bulk Update button 
appears above the tree list. Check boxes display next to nodes. After choosing Bulk 
Update, a dialog box displays attributes available for update. 

You can also use the drag and drop feature to move nodes to a parent node. 

The following attributes are available for bulk update:

■ Parent

Note: You can only inactivate nodes with "Active" or "Archived" 
status. 

Note: You can only archive nodes with "Active" or "Inactive" status.
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■ Status (Active, Inactive, Archive)

To perform a bulk update:

1. Select items by clicking the corresponding checkbox. 

2. Click Bulk Update. A dialog box lists all fields available for bulk update. 

3. Select the attribute to change, then click Apply Changes. 

4. Click Save to save the changes, or Cancel to exit without saving your changes.
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Custom Data
Customer-specific data, or custom data, is available in Agile PLM for Process in the 
form of custom sections and extended attributes. As an administrator, you can 
maintain custom data lists using the ADMN application. For more information about 
setting up custom sections and extended attributes, see Chapter 3, "Using ADMN to 
Manage Custom Data".

Category Tabs
Use the Category Tabs list to create custom data categories. These categories display as 
inline tabs used to organized extended attributes and custom sections on objects. 
Category tabs are associated directly to the extended attribute or custom section, see 
"Creating an Extended Attribute" on page 3-27 and "Creating a Custom Section" on 
page 3-39 for more information.

Figure 2–12 Category Tabs list

Key Fields

Editing Rules
For instructions on editing the Category Tab list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–1 Custom Data, CategoryTabs key fields

Name Description

Name The category tab name

Behavior ID The system-assigned category tab ID

Available In Specify which custom data this category applies to. For example, 
if you only want to use this category tab for extended attributes 
then select Extended Attribute.

Status The assigned status for the category tab. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Custom Section Column Tags
Use the Custom Section Column Tags list in ADMN to maintain custom section 
columns tags, as Figure 2–13 shows.

Figure 2–13 Custom Section Column Tags list

Key Fields

Editing Rules
For instructions on editing the Custom Section Column Tags list, see "Maintaining 
Simple Lists" on page 2-4. 

Table 2–2 Custom Data, Custom Section Column Tags key fields

Name Description

Name The custom section column tag name

Behavior ID The system-assigned column tag ID

Status The assigned status for the custom section column tag. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Custom Section Order
Use the Custom Section Order list in ADMN to maintain the order of custom sections, 
as Figure 2–14 shows. For instructions on setting order, see "Setting Custom Section 
Order" on page 3-58.

Figure 2–14 Custom Section Order list

Key Fields

Display Filters
Use the Display Filters to hide/show sections based on status and/or category.

Editing Rules
For instructions on editing the Custom Section Order list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–3 Custom Data, Custom Section Order key fields

Name Description

Order Order of custom sections

Name The custom section name

Category The associated category tab.

Status The assigned status for the custom section. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Custom Section Row Tags
Use the Custom Section Row Tags list in ADMN to maintain custom section row tags, 
as Figure 2–15 shows.

Figure 2–15 Custom Section Row Tags list

Key Fields

Editing Rules
For instructions on editing the Custom Section Row Tags list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–4 Custom Data, Custom Section Row Tags key fields

Name Description

Name The custom section row tag name

Behavior ID The system-assigned custom section row tag ID

Status The assigned status for the custom section row tag. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Custom Section Tab Order
Use the Custom Section Tab Order list in ADMN to maintain custom section tab order, 
as Figure 2–20 shows. You can have a different tab order by object type. If no order is 
specified, tabs display in alphabetical order.

Figure 2–16 Custom Section Tab Order list

Key Fields

Editing Rules
For instructions on editing the Custom Section Tab Order list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–5 Custom Data, Custom section tab order key fields

Name Description

Order Order of custom section tab

Name The custom section tab name

Status The assigned status for the custom section tab. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Custom Section Tags
Use the Custom Section Tags list in ADMN to maintain custom section tags, as 
Figure 2–17 shows.

Figure 2–17 Custom Section Tags list

Key Fields

Editing Rules
For instructions on editing the Custom Section Tag list, see "Maintaining Simple Lists" 
on page 2-4. 

Table 2–6 Custom Data, Custom Section Tags key fields

Name Description

Name The custom section tag name

Behavior ID The system-assigned custom section tag ID

Status The assigned status for the custom section tag. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Extended Attribute Groups
Use the Extended Attribute Groups list in ADMN to maintain extended attribute 
groups, as Figure 2–18 shows.

Figure 2–18 Extended Attribute Groups list

Key Fields

Editing Rules
For instructions on editing the Extended Attribute Group list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–7 Custom Data, Extended Attribute Groups key fields

Name Description

Name The extended attribute group name

Status The assigned status for the extended attribute group. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Extended Attribute Order
Use the Extended Attribute Order list in ADMN to maintain the order of extended 
attributes, as Figure 2–19 shows. For instructions on setting order, see "Setting 
Extended Attribute Order" on page 3-30.

Figure 2–19 Extended Attribute Order list

Key Fields

Display Filters
Use the Display Filters to hide/show extended attributes based on status and/or 
category.

Editing Rules
For instructions on editing the Extended Attribute Order list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–8 Custom Data, Extended Attribute Order key fields

Name Description

Order Order of extended attributes

Name The extended attribute name

Category The associated category tab.

Status The assigned status for the extended attribute. Refer to 
"Statuses" on page 2-3 for status descriptions.



Custom Data

Using ADMN to Manage Core Data 2-23

Extended Attribute Tab Order
Use the Extended Attribute Tab Order list in ADMN to maintain extended attribute 
tab order, as Figure 2–20 shows. You can have a different tab order by object type. If no 
order is specified, tabs display in alphabetical order.

Figure 2–20 Extended Attribute Tab Order list

Key Fields

Editing Rules
For instructions on editing the Extended Attribute Tab Order list, see "Maintaining 
Simple Lists" on page 2-4. 

Table 2–9 Custom Data, Extended attribute tab order key fields

Name Description

Order Order of extended attribute tab

Name The extended attribute tab name

Status The assigned status for the extended attribute tab. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Extended Attribute Tags
Use the Extended Attribute Tags list in ADMN to maintain extended attribute tags, as 
Figure 2–21 shows.

Figure 2–21 Extended Attribute Tags list

Key Fields

Editing Rules
For instructions on editing the Extended Attribute Tag list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–10 Custom Data, Extended Attribute Tags key fields

Name Description

Name The extended attribute tag name

Behavior ID The system-assigned extended attribute tag ID

Status The assigned status for the extended attribute tag. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Custom Portal
The Custom Portal is an extension of the Oracle Agile PLM for Process application 
suite. It allows customers to implement various integration solutions that leverage the 
PLM for Process data and capabilities without using the core application. Its primary 
usage is to provide a framework for searching, filtering, and displaying PLM for 
Process data, and gives solution implementers the ability to customize each of those 
aspects.

Custom Portals
Use the Custom Portals list in ADMN to maintain custom portals, as Figure 2–22 
shows.

Figure 2–22 Custom Portals list

Key Fields

Editing Rules
For instructions on editing the Custom Portals list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–11 Custom Portal, Custom Portals key fields

Name Description

Name The custom portal name

Cache Timeout (minutes) The number of minutes that the search results are cached

Status The assigned status for the custom portal. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Custom Portal Views
Use the Custom Portal Views list in ADMN to maintain custom portal views, as 
Figure 2–23 shows.

Figure 2–23 Custom Portal Views list

Key Fields

Editing Rules
For instructions on editing the Custom Portal Views list, see "Maintaining Simple 
Lists" on page 2-4.

See the Agile Product Lifecycle Management for Process Custom Portal Implementation 
Guide for more information about plugins.

Table 2–12 Custom Portal, Custom Portal Views key fields

Name Description

Name The custom portal view name

Search Plugin Name of the search plugins used to display portal views

Rendering Plugin Name of the rendering plugin configured for the view

Filter Control Name of the filter control for the view

Open New Window If checked, the view opens in a new window. If unchecked, it 
opens in the same window.

Status The assigned status for the custom portal view. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Document Reference Library Data
The Document Reference Library (DRL) is a repository for business documents. As an 
administrator, you can control the catalog and classification lists using the ADMN 
application. For more information about DRL, see the Agile Product Lifecycle 
Management for Process Document Reference Library User Guide.

Catalogs
Catalogs are used to organize DRL documents. Once the catalog is defined, it can be 
used within the Document Reference Library and other Agile PLM for Process 
applications that use DRL. Catalogs are also used to control a user or supplier’s 
visibility to DRL documents. For example, a user may only have rights to see 
documents in the "Public" catalog, not the "Classified" catalog. 

Documents are associated with catalogs on the DRL document object. Use the Catalogs 
tree list in ADMN to maintain the data, as Figure 2–24 shows.

Figure 2–24 Catalogs tree list

Editing Rules
For instructions on editing the Catalogs tree list, see "Maintaining Tree Lists" on 
page 2-9. 
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Classifications
A DRL document can be associated with multiple classification values. The 
classification value is just for informational purposes.

Classifications are assigned on the DRL document object. Use the Classification list in 
ADMN to maintain the data, as Figure 2–25 shows.

Figure 2–25 Classifications tree list

Editing Rules
For instructions on editing the Classification tree list, see "Maintaining Tree Lists" on 
page 2-9. 
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Global Data
Administrators maintain global data—data that is consumed throughout Agile PLM 
for Process by the various applications. This data includes countries, cross- references, 
restrictions, substitute restrictions, and units of measure. 

Attachment Tags
Use the Attachment Tags list in ADMN to maintain the data, as Figure 2–26 shows.

Figure 2–26 Attachment Tags list

Key Fields

Editing Rules
For instructions on editing the Attachment Tags list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–13 Global, Attachment Tags key fields

Name Description

Name The attachment tag name

Status The assigned status for the attachment tag. Refer to "Statuses" on 
page 2-3 for status descriptions.

Object Type > Object 
Subtype

Select the object and or object subtype where you would like the 
item to appear. For example, if you select Material Specification 
> Raw Material, the item is only available for selection when the 
specification type is a Material Specification and the sub type is 
"Raw Material".
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Countries
Use the Countries list in ADMN to maintain the data, as Figure 2–27 shows. 

Figure 2–27 Countries list

Key Fields

Editing Rules
For instructions on editing the Countries list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–14 Global, Countries key fields

Name Description

Country Name The country name

Country ID The commonly recognized three-letter country ID

ISO Code The commonly recognized two-letter ISO code for the country

Status The assigned status for the country. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Cross Reference Statuses
The Cross Reference Status section lists statuses of systems that can be cross 
referenced, as Figure 2–28 shows.

Figure 2–28 Cross Reference Status list

Key Fields

Editing Rules
For instructions on editing the Cross Reference list, see "Maintaining Simple Lists" on 
page 2-4.

Reordering Cross Reference Statuses  

Only users with the role of [SUPER_DATA_ADMIN] can reorder cross reference 
statuses. For instructions on setting the order, see "To reorder data in a simple list:" on 
page 2-6.

Table 2–15 Global, Cross Reference Status key fields

Name Description

System Name The name of the cross reference status

System Type The code assigned to the system during integration. Choices are 
Inactive and Active. This tells system how to treat the cross 
reference. This is a required field.

Status The assigned status for the cross-reference status. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default Indicates the default cross reference status.
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Cross References
The Cross References section lists external systems containing equivalent numbers that 
can be referenced.

Administrators maintain the cross-references and can set whether the cross reference is 
managed by an external system, as Figure 2–29 shows. When the Managed Externally 
Default box is checked, the corresponding system name is read only on the 
specifications.

Figure 2–29 Cross References list

Key Fields

Editing Rules
For instructions on editing the Cross Reference list, see "Maintaining Simple Lists" on 
page 2-4 (simple list display) or "Maintaining Tree Lists" on page 2-9 (tree list display). 
For more information on user roles, refer to Appendix A, "System-Based Roles" of the 
Agile Product Lifecycle Management for Process User Group Management User Guide. 

Note: Depending on configuration settings, this list may display as a 
tree list. The Available In field can be turned on or off using a 
configuration setting. Refer to the Agile Product Lifecycle Management 
for Process Configuration Guide for more information. 

Table 2–16 Global, Cross References key fields

Name Description

Available In Used to associate a system name to a Business Unit taxonomy.

System Name The name of the system

System Code The code assigned to the system during integration

Managed Externally 
Default

Check the box if you want external systems to provide the 
cross-reference equivalent number. If the box is checked, a GSM 
user cannot edit the Cross Reference field unless the GSM user 
has the role of [EXTERNALLY_MANAGED_CROSS_REF_
ADMIN]. This field may not display based on configuration 
settings.

Status The assigned status for the cross-reference. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Data Groups
Data groups are used to organize and filter select data lists in consumption. Use the 
Data Group list in ADMN to maintain the data, as Figure 2–30 shows.

Figure 2–30 Data Groups list

Key Field

Editing Rules
For instructions on editing the Data Groups list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–17 GSM Common, Data Groups key field

Name Description

Name Name of the data group

Status The assigned status for the data group. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Document Tags
Use the Document Tags list in ADMN to maintain the data, as Figure 2–31 shows.

Figure 2–31 Document Tags list

Key Fields

Editing Rules
For instructions on editing the Document Tags list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–18 Global, Document Tags key fields

Name Description

Name The document tag name

Status The assigned status for the document tag. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Restrictions
Restrictions data includes food restrictions by agency. For example, restrictions might 
include the following:

■ CFIA (Canadian Food Inspection Agency) restrictions

■ EU (European Union) restrictions

■ FDA (Food and Drug Administration) restrictions

■ USDA (United States Department of Agriculture) restrictions

Use the Restrictions tree list in ADMN to maintain the data, as Figure 2–32 shows.

Figure 2–32 Restrictions tree list

Editing Rules
For instructions on editing the Restrictions tree list, see "Maintaining Tree Lists" on 
page 2-9. 
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Segments
Use the Segments tree list in ADMN to maintain the data, as Figure 2–33 shows.

Figure 2–33 Segments tree list

Editing Rules
For instructions on editing the Segments tree list, see "Maintaining Tree Lists" on 
page 2-9. 
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States/Provinces
Use the States/Provinces list in ADMN to maintain the data, as shows.

Figure 2–34 States/Provinces list

Key Fields

Editing Rules
For instructions on editing the Substitute Restrictions list, see "Maintaining Simple 
Lists" on page 2-4. 

Table 2–19 Global, States/Provinces key fields

Name Description

States/Provinces Name Name of the state or province

States/Provinces ID The commonly recognized abbreviation ID for the state or 
province.

ISO Code The commonly recognized ISO code for the country and state or 
province. 

Country ID The commonly recognized abbreviation ID for the country.

Status The assigned status for the state or province. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Substitute Restrictions
Use the Substitute Restrictions list in ADMN to maintain substitute restrictions, as 
Figure 2–35 shows.

Figure 2–35 Substitute Restrictions list

Key Fields

Editing Rules
For instructions on editing the Substitute Restrictions list, see "Maintaining Simple 
Lists" on page 2-4. 

Reordering Substitute Restrictions  

Only users with the role of [SUPER_DATA_ADMIN] can reorder substitute 
restrictions. For instructions on setting the order, see "To reorder data in a simple list:" 
on page 2-6.

Table 2–20 Global, Substitute Restrictions key fields

Name Description

Name Name of the substitute restriction

Status The assigned status for the substitute restriction. Refer to 
"Statuses" on page 2-3 for status descriptions.
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UOM
Use the UOM (Units of Measure) list in ADMN to maintain your own units of 
measures and categories that can be consumed in PLM for Process specifications and 
integrated with ERP systems, as Figure 2–36 shows.

Figure 2–36 UOM list - DR 31355/34983

Key Fields

Table 2–21 Global, UOM key fields

Name Description

Category The unit of measure category. Choices are: Length (M), Mass 
(KG), Volume (L), Unit (U), Time (SEC) and Other. 

Base UOM The base UOM abbreviation value defined for the selected 
category. This field is read-only. 

Name The name of the unit of measure. This is a translatable field.

Abbreviation The commonly used abbreviation for the unit of measure. This is 
a translatable field.

Factor The factor of convert to the base unit of measure.

ID The unit of measure identification number.

ISO Code The commonly recognized two-letter ISO code for the unit of 
measure. 

Status The assigned status for the unit of measure. Refer to "Statuses" 
on page 2-3 for status descriptions. A system UOM is defined by 
default. 
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Editing Rules
To add a unit of measure:

1. Click Add. Agile PLM for Process displays the UOM Summary page, shown in 
Figure 2–37.

Figure 2–37 UOM Summary page

2. Provide data in the fields described in Table 2–21 above. All fields are required and 
each UOM must be distinct.

3. Click Save & Close. The new unit of measure is added to the data list. 

4. Flush the administrator data cache group, as described in "Using the Cache 
Application" on page 4-3.

Reordering UOMs  

Only users with the role of [SUPER_DATA_ADMIN] can reorder UOMs. See "To 
reorder data in a simple list:" on page 2-6 for instructions on setting the order of UOM 
data.
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Global Specification Management Common Data
Using the ADMN application, you can modify data that is common in Global 
Specification Management (GSM). 

Brands - (GSM Legacy Free Text)
Use the Brands - (GSM Legacy Free Text) list in ADMN to maintain the data, as 
Figure 2–39 shows. This list is deprecated and will be removed in a future release.

Figure 2–38 Brands - (GSM) Legacy Free Text list

Key Fields

Editing Rules
For instructions on editing the Brands - (GSM Legacy Free Text) list, see "Maintaining 
Simple Lists" on page 2-4. 

Table 2–22 GSM Common, Brands - (GSM Legacy Free Text) key fields

Name Description

Name Name of the brand in GSM. This is used for legacy free text 
entry. 

Status The assigned status for the brand. Refer to "Statuses" on page 2-3 
for status descriptions.
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Brands - (GSM)
Use the Brands - (GSM) list in ADMN to maintain the data, as Figure 2–39 shows.

Figure 2–39 Brands - (GSM) list

Key Fields

Editing Rules
For instructions on editing the Brands - (GSM) list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–23 GSM Common, Brands - (GSM) key fields

Name Description

Name Name of the brand in GSM

Status The assigned status for the brand. Refer to "Statuses" on page 2-3 
for status descriptions.
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Business Units - (GSM)
Use the Business Units - (GSM) tree list in ADMN to maintain the data, as Figure 2–40 
shows.

Figure 2–40 Business Units - (GSM) tree list

Editing Rules
For instructions on editing the Business Units - (GSM) tree list, see "Maintaining Tree 
Lists" on page 2-9. 
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Classification
Use the Classification list in ADMN to maintain the data, as Figure 2–41 shows.

Figure 2–41 Classification list

Key Fields

Editing Rules
For instructions on editing the Classification list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–24 GSM Common, Classification key fields

Name Description

Name Name of the classification

Status The assigned status for the classification. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Concepts
Use the Concepts tree list in ADMN to maintain the data, as Figure 2–42 shows.

Figure 2–42 Concepts tree list

Editing Rules
For instructions on editing the Concepts tree list, see "Maintaining Tree Lists" on 
page 2-9. 
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Document Status
Use the Document Status list in ADMN to maintain the GSM supporting document 
status list, as Figure 2–43 shows.

Figure 2–43 Document Status list

Key Fields

Editing Rules
For instructions on editing the Document Status list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–25 GSM, Document Status key fields

Name Description

Name Name of the document status.

Behavior ID The document status ID

Default Indicates the default document status

Status The assigned status for the document status. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Document Type
Use the Document Type list in ADMN to maintain document type options for GSM 
supporting documents, as Figure 2–87 shows.

Figure 2–44 Document Type list

Key Fields

Editing Rules
For instructions on editing the Document Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–26 GSM, Document Type key fields

Name Description

Name Name of the document type.

Behavior ID The unique behavior ID that is defined by the system.

Status The assigned status for the document type. Refer to "Statuses" on 
page 2-3 for status descriptions.

Object Type > Object 
Subtype

Select the object and or object subtype where you would like the 
item to appear. For example, if you select Material Specification 
> Raw Material the item will only be available for selection 
when the specification type is a Material Specification and the 
sub type is "Raw Material".
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Environmental Waste
Use the Environmental Waste list in ADMN to maintain the data, as Figure 2–45 
shows.

Figure 2–45 Environmental Waste list

Key Fields

Editing Rules
For instructions on editing the Environmental Waste list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–27 GSM Common, Environmental Waste key fields

Name Description

Name Name of the environmental waste

Status The assigned status for the environmental waste. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Formulation Classification
Formula classifications are used to secure % breakdowns on material, product, and 
trade specifications. Use the Formula Classification list in ADMN to maintain the data, 
as Figure 2–46 shows.

Figure 2–46 Formula Classifications list

Key Fields

Editing Rules
For instructions on editing the Formula Classification list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–28 GSM Common, Formula Classification key fields

Name Description

Name Name of the formula classification

Group(s) User groups that have access to the formula classification. User 
groups are managed using UGM. For more information, refer to 
the Agile Product Lifecycle Management for Process User Group 
Management User Guide.

Status The assigned status for the formula classification. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Formulation Item Type
Use the Formulation Item Type list in ADMN to maintain the data, as Figure 2–45 
shows.

Figure 2–47 Formulation Item Type list

Key Fields

Editing Rules
For instructions on editing the Formulation Item Type list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–29 GSM Common, Formulation Item Type key fields

Name Description

Name Name of the formulation item

System Type Name of the system type

Status The assigned status for the formulation item type. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default A check indicates the default formulation item type
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Formulation Tags
Use the Formulation Tags list in ADMN to maintain the data, as Figure 2–48 shows.

Figure 2–48 Formulation Tags list

Key Fields

Editing Rules
For instructions on editing the Formulation Tags list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–30 Formulation Tags key fields

Name Description

Name Name of the substitute material tag

Behavior ID The system-assigned column tag ID

Behaviors The specific attribute that is being targeted for loss

Available In The output that the formulation is available in. This is a required 
field.

Status The assigned status for the formulation tag. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Formula Output Types - External
Use the Formula Output Type - External list in ADMN to maintain the data, as 
Figure 2–49 shows.

Figure 2–49 Formula Output Type - External list

Key Fields

Editing Rules
For instructions on editing the formula output types - external list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–31 Formula output type - external key fields

Name Description

Name Name of the formula output type.

Status The assigned status for the formula output type. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default A check indicates the default output type.
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Formula Output Types - Internal
Use the Formula Output Type - Internal list in ADMN to maintain the data, as 
Figure 2–49 shows. 

Figure 2–50 Formula Output Type - Internal list

Key Fields

Editing Rules
For instructions on editing the formula output types - internal list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–32 Formula output type - internal key fields

Name Description

Name Name of the formula output type.

Status The assigned status for the formula output type. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default A check indicates the default output type.
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Formula Output Types - Referenced
Use the Formula Output Type - Internal list in ADMN to maintain the data, as 
Figure 2–49 shows. 

Figure 2–51 Formula Output Type - Referenced list

Key Fields

Editing Rules
For instructions on editing the formula output types - referenced list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–33 Formula output type - referenced key fields

Name Description

Name Name of the formula output type.

Status The assigned status for the formula output type. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default A check indicates the default output type.
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Label Claims
Use the Label Claims list in ADMN to maintain the data, as Figure 2–52 shows.

Figure 2–52 Label Claims list

Key Fields

Editing Rules
For instructions on editing the Label Claims list, see "Maintaining Simple Lists" on 
page 2-4. 

Table 2–34 GSM Common, Label Claims key fields

Name Description

Name Name of the label claim

Is Calculatable Indicates whether the label claim is associated to a label claim 
determination rule. This flag is not editable through ADMN and 
must be scripted in.

Status The assigned status for the label claim. Refer to "Statuses" on 
page 2-3 for status descriptions.



Global Specification Management Common Data

2-56 Agile Product Lifecycle Management for Process Administrator User Guide

Label Claims Classifications
Use the Label Claims Classifications list in ADMN to maintain label claims 
classifications, as Figure 2–53 shows.

Figure 2–53 Label Claims Classifications list

Key Fields

Editing Rules
For instructions on editing the Label Claims Classifications list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–35 GSM Common, Label Claims Classifications key fields

Name Description

Name Name of the label claim classification

Status The assigned status for the label claim classification. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Label Owner
Use the Label Owner list in ADMN to maintain the label owner data, as Figure 2–54 
shows.

Figure 2–54 Label Owner list

Key Fields

Editing Rules
For instructions on editing the Label Owner list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–36 GSM Common, Label Owner key fields

Name Description

Name Name of the label owner

Status The assigned status for the label owner. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Menu Item Class
Use the Menu Item Class list in ADMN to maintain the menu item classifications, as 
Figure 2–55 shows.

Figure 2–55 Menu Item Class list

Key Field

Editing Rules
For instructions on editing the Menu Item Class list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–37 GSM Common, Menu Item Class key field

Name Description

Name Name of the menu item class

Status The assigned status for the menu item class. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Menu Item Standard
Use the Menu Item Standard list in ADMN to maintain the menu item standards, as 
Figure 2–56 shows.

Figure 2–56 Menu Item Standard list

Key Fields

Editing Rules
For instructions on editing the Menu Item Standard list, see "Maintaining Simple Lists" 
on page 2-4.

Table 2–38 GSM Common, Menu Item Standard key fields

Name Description

Locality The region that the menu item standard applies to. This field is 
for administrative informational purposes only.

Compliance The compliance value for the menu item standard. This field is 
for administrative informational purposes only.

Name Name of the menu item standard

Status The assigned status for the menu item standard. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Nutp Special Attributes 
Use the Nutrient Profile Special Attributes list in ADMN to maintain the data, as 
Figure 2–57 shows.

Figure 2–57 Nutrient Profile Special Attributes list

Key Fields

Editing Rules
For instructions on editing the Nutrient Profile Special Attributes list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–39 GSM Common, Nutrient Profile Special Attributes key fields

Name Description

Name Name of the nutrient profile special attribute

Status The assigned status for the nutrient profile special attribute. 
Refer to "Statuses" on page 2-3 for status descriptions.
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Nutrient Source
Use the Nutrient Source list in ADMN to maintain the data, as Figure 2–58 shows. 

Figure 2–58 Nutrient Source list

Key Fields

Editing Rules
For instructions on editing the Nutrient Source list, see "Maintaining Simple Lists" on 
page 2-4. 

Reordering Nutrient Sources  

Only users with the role of [SUPER_DATA_ADMIN] can reorder nutrient sources. For 
instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–40 GSM Common, Nutrient Source key fields

Name Description

Name Name of the nutrient source

Status The assigned status for the nutrient source. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Packaging Type
Use the Packaging Type list in ADMN to maintain the data, as Figure 2–59 shows.

Figure 2–59 Packaging Type list

Key Fields

Editing Rules
For instructions on editing the Packaging Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–41 GSM Common, Packaging Type key fields

Name Description

Name Name of the packaging type

ISO Code Name of the related ISO code. For more information, see "ISO 
Codes" on page A-4. 

Status The assigned status for the packaging type. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Packaging Item Type
Use the Packaging Item Type list in ADMN to maintain the data, as Figure 2–60 shows.

Figure 2–60 Packaging Item Type list

Key Fields

Editing Rules
For instructions on editing the Packaging Item Type list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–42 GSM Common, Packaging Item Type key fields

Name Description

Name Name of the packaging item type

Status The assigned status for the packaging item type. Refer to 
"Statuses" on page 2-3 for status descriptions.

Default Indicates which packaging item type is set as default
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Printed Packaging Languages
Use the Printed Packaging Languages list in ADMN to maintain the data, as 
Figure 2–61 shows.

Figure 2–61 Printed Packaging Languages list

Key Fields

Editing Rules
For instructions on editing the Printed Packaging Languages list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–43 GSM Common, Printed Packaging Languages key fields

Name Description

Name Name of the printed packaging language

Status The assigned status for the printed packaging language. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Raw Material Types
Use the Raw Material Types list in ADMN to maintain the data, as Figure 2–62 shows.

Figure 2–62 Raw Materials list

Key Fields

Editing Rules
For instructions on editing the Raw Materials list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–44 GSM Common, Raw Materials key fields

Name Description

Name Name of the raw material

Status The assigned status for the raw material. Refer to "Statuses" on 
page 2-3 for status descriptions.

Default The raw material type that is automatically selected when a new 
material specification is created. 
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Shelf Life Type
Use the Shelf Life Type list in ADMN to maintain the data, as Figure 2–63 shows.

Figure 2–63 Shelf Life Type list

Key Fields

Editing Rules
For instructions on editing the Shelf Life Type list, see "Maintaining Simple Lists" on 
page 2-4.

Reordering Shelf Life Types  

Only users with the role of [SUPER_DATA_ADMIN] can reorder shelf life types. For 
instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–45 GSM Common, Shelf Life Type key fields

Name Description

Name Name of the shelf life type

ID Unique identifier for the shelf life type

Status The assigned status for the shelf life type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Smart Issue Status
Use the Smart Issue Status list in ADMN to maintain the data, as Figure 2–64 shows.

Figure 2–64 Smart Issue Status list

Key Fields

Editing Rules
For instructions on editing the Smart Issue Status list, see "Maintaining Simple Lists" 
on page 2-4.

Reordering Smart Issue Status  

Only users with the role of [SUPER_DATA_ADMIN] can reorder smart issue status 
types. For instructions on setting the order, see "To reorder data in a simple list:" on 
page 2-6.

Table 2–46 GSM Common, Smart Issue Status key fields

Name Description

Name Name of the smart issue status

Status The assigned status for the smart issue status. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Storage and Shipping Requirements
Use the Storage and Shipping Requirements list in ADMN to maintain the data, as 
Figure 2–65 shows. 

Figure 2–65 Storage and Shipping Requirements list

Key Fields

Editing Rules
For instructions on editing the Storage and Shipping Requirements list, see 
"Maintaining Simple Lists" on page 2-4.

Note: This list controls the material specification’s Storage 
Requirements field inside the shelf life grid as well as the product 
specification’s Shipping Conditions field.

Table 2–47 GSM Common, Storage and Shipping Requirements key fields

Name Description

Name Name of the storage and shipping requirement

Status The assigned status for the storage and shipping requirement. 
Refer to "Statuses" on page 2-3 for status descriptions.
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Storage Requirements (Trade Specs)
Use the Storage Requirements (Trade Specs) list in ADMN to maintain the data, as 
Figure 2–66 shows. 

Figure 2–66 Storage Requirements (Trade Specs) list

Key Fields

Editing Rules
For instructions on editing the Storage Requirements (Trade Spec) list, see 
"Maintaining Simple Lists" on page 2-4.

Note: This list controls the trade specification’s Storage 
Requirements field.

Table 2–48 GSM Common, Storage Requirements (Trade Specs) key fields

Name Description

Name Name of the trade specification storage requirement

Status The assigned status for the trade specification storage 
requirement. Refer to "Statuses" on page 2-3 for status 
descriptions.
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Substitute Material Tags
Use the Substitute Material Tags list in ADMN to maintain the data, as Figure 2–67 
shows.

Figure 2–67 Substitute Material Tags list 

Key Fields

Editing Rules
For instructions on editing the Substitute Material Tags list, see "Maintaining Simple 
Lists" on page 2-4.

Reordering Substitute Material Tags  

Only users with the role of [SUPER_DATA_ADMIN] can reorder substitute material 
tags. For instructions on setting the order, see "To reorder data in a simple list:" on 
page 2-6.

Table 2–49 Substitute Material Tags key fields

Name Description

Name Name of the substitute material tag

Status The assigned status for the substitute material tag. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Trade Item Type
Use the Trade Item Type list in ADMN to maintain the Item Type field on a GSM trade 
specification. This list allows you to customize the Item Type name shown and tie it to 
a system type. The System type controls which sections and fields are shown on the 
trade specification. This list is shown in Figure 2–68 below.

Figure 2–68 Trade Item Type list

Key Fields

Figure 2–69 shows which sections and fields are displayed based on the system type 
selected.   CU = Consumer Unit and TU = Traded Unit

Table 2–50 Trade Item Type key fields

Name Description

Name Name of the trade item type that displays to the user.

Is Discrete When an item type is flagged with isDiscrete, the trade 
specification hides the Nutrient Profile section, Related Material 
Specification section, and the Compliance, Allergens, 
Intolerances, Additives sections. Discrete always shows 
suppliers regardless of system type selected.

System Type This type controls which fields are available on the trade 
specification when a trade item type is selected. Refer to 
Figure 2–69 detailing what each system type shows.

Status The assigned status for the trade item type. Refer to "Statuses" 
on page 2-3 for status descriptions.

Default The trade type that is automatically selected when a blank trade 
specification is created. 
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Figure 2–69 System Types

Editing Rules
For instructions on editing the Trade Item Type list, see "Maintaining Simple Lists" on 
page 2-4.
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Trade Tax Type/Rate
Use the Trade Tax Type/Rate list in ADMN to maintain the trade tax type/rate, as 
Figure 2–70 shows. 

Figure 2–70 Trade Tax Type/Rate list

Key Fields

Editing Rules
For instructions on editing the Trade Tax Type/Rate list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–51 GSM Common, Trade Tax Type/Rate key fields

Name Description

Name Name of the trade tax type/rate

Status The assigned status for the trade tax type/rate. Refer 
to"Statuses" on page 2-3 for status descriptions.
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Trade UNSPSC Code
Use the Trade United Nations Standard Products and Services Code (UNSPSC 
(UNSPSC) Code list in ADMN to maintain the list, as Figure 2–71 shows. 

Figure 2–71 Trade UNSPSC Code list

Editing Rules
For instructions on editing the Trade UNSPSC Code tree list, see "Maintaining Tree 
Lists" on page 2-9.
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Trading Company
Use the Trading Company list in ADMN to maintain the fields, as Figure 2–72 shows. 

Figure 2–72 Trading Company list

Key Fields

Editing Rules
For instructions on editing the Trading Company list, see "Maintaining Simple Lists" 
on page 2-4.

Table 2–52 GSM Common, Trading Company key fields

Name Description

Name Name of the trading company

GLN The Global Location Number, a globally unique 13-digit number 
that identifies physical location, legal entity, and functional 
entity of the trading company

Status The assigned status for the trading company. Refer to"Statuses" 
on page 2-3 for status descriptions.
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UDEX Classifications
Use the UDEX Classifications list in ADMN to maintain the data, as Figure 2–73 
shows.

Figure 2–73 GSM Common, UDEX Classifications tree list

Editing Rules
For instructions on editing the UDEX Classifications tree list, see "Maintaining Tree 
Lists" on page 2-9.
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Global Specification Management Compliance Data

Additives
Use the Additives list in ADMN to maintain the data, as Figure 2–74 shows.

Figure 2–74 Additives list

Key Fields

Editing Rules
For instructions on editing the Additives list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–53 GSM Compliance, Additives key fields

Name Description

Name Name of the additive

External Id Unique identification for the additive

UOM Unit of measure for the additive

Status The assigned status for the additive. Refer to "Statuses" on 
page 2-3 for status descriptions.

Data Groups Group used to filter the additives list
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Allergens
Use the Allergens list in ADMN to maintain the data, as Figure 2–75 shows.

Figure 2–75 Allergens list

Key Fields

Editing Rules
For instructions on editing the Allergens list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–54 GSM Compliance, Allergens key fields

Name Description

Name Name of the allergen

External Id Unique identification for the allergen

UOM Unit of measure for the allergen

Status The assigned status for the allergen. Refer to "Statuses" on 
page 2-3 for status descriptions.

Data Groups Group used to filter the allergens list
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Complies With
Use the Complies With list in ADMN to maintain the data, as Figure 2–76 shows.

Figure 2–76 Complies With list

Key Fields

Editing Rules
For instructions on editing the Complies With list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–55 GSM Compliance, Complies With key fields

Name Description

Name Name of the compliance item

Is Negative Indicates whether the item is negative. This flag is used when 
complies with items are rolled up during formulation. If an item 
is marked as Negative it is rolled up as present if it appears at all 
in the group of formulation inputs. If an item is not marked as 
Negative, then it only roll ups as present if all formulation 
inputs contain the complies with item.

Status The assigned status for the compliance item. Refer to "Statuses" 
on page 2-3 for status descriptions.

Data Groups Group used to filter the complies with list
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Intolerances
Use the Intolerances list in ADMN to maintain the data, as Figure 2–77 shows.

Figure 2–77 Intolerances list

Key Fields

Editing Rules
For instructions on editing the Intolerances list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–56 GSM Compliance, Intolerances key fields

Name Description

Name Name of the intolerance

External Id Unique identification for the intolerance

UOM Unit of measure for the intolerance

Status The assigned status for the intolerance. Refer to "Statuses" on 
page 2-3 for status descriptions.

Data Groups Group used to filter the intolerances list
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Global Specification Management FSIS Data

Application Status
Use the Application Status list in ADMN to maintain the data, as Figure 2–78 shows.

Figure 2–78 Application Status list

Key Fields

Editing Rules
For instructions on editing the Application Status list, see "Maintaining Simple Lists" 
on page 2-4.

Reordering Application Statuses  

Only users with the role of [SUPER_DATA_ADMIN] can reorder application statuses. 
For instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–57 GSM FSIS, Application Status key fields

Name Description

Name Name of the FSIS application status 

Status The assigned status for the FSIS application status. Refer to 
"Statuses" on page 2-3 for status descriptions.
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CFIA Approval Type
Use the CFIA Approval Types list in ADMN to maintain approval types, as 
Figure 2–79 shows.

Figure 2–79 CFIA Approval Types list

Key Fields

Editing Rules
For instructions on editing the CFIA Approval Type list, see "Maintaining Simple 
Lists" on page 2-4.

Reordering CFIA Approval Types  

Only users with the role of [SUPER_DATA_ADMIN] can reorder CFIA approval types. 
For instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–58 GSM FSIS, CFIA Approval Type key fields

Name Description

Name Name of the FSIS CFIA approval type

Status The assigned status for the FSIS CFIA approval type. Refer to 
"Statuses" on page 2-3 for status descriptions.
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CFIA Payment Method
Use the CFIA Payment Method list in ADMN to maintain payment methods, as 
Figure 2–80 shows.

Figure 2–80 CFIA Payment Method list

Key Fields

Editing Rules
For instructions on editing the CFIA Payment Method list, see "Maintaining Simple 
Lists" on page 2-4.

Reordering CFIA Payment Methods  

Only users with the role of [SUPER_DATA_ADMIN] can reorder CFIA payment 
methods. For instructions on setting the order, see "To reorder data in a simple list:" on 
page 2-6.

Table 2–59 GSM FSIS, CFIA Payment Method key fields

Name Description

Name Name of the FSIS CFIA payment method

Status The assigned status for the FSIS CFIA payment method. Refer to 
"Statuses" on page 2-3 for status descriptions.
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CFIA Product Type
Use the CFIA Product Type list in ADMN to maintain the product type data, as 
Figure 2–81 shows.

Figure 2–81 CFIA Product Type list

Key Fields

Editing Rules
For instructions on editing the CFIA Product Type list, see "Maintaining Simple Lists" 
on page 2-4.

Reordering CFIA Product Types  

Only users with the role of [SUPER_DATA_ADMIN] can reorder CFIA product types. 
For instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–60 GSM FSIS, CFIA Product Type key fields

Name Description

Name Name of the FSIS CFIA product type

Status The assigned status for the FSIS CFIA product type. Refer to 
"Statuses" on page 2-3 for status descriptions.
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USDA HACCP Category
Use the USDA HACCP Category list in ADMN to maintain the data, as Figure 2–82 
shows.

Figure 2–82 USDA HACCP Category list

Key Fields

Editing Rules
For instructions on editing the USDA HACCP list, see "Maintaining Simple Lists" on 
page 2-4.

Reordering USDA HACCP Categories  

Only users with the role of [SUPER_DATA_ADMIN] can reorder USDA HACCP 
categories. For instructions on setting the order, see "To reorder data in a simple list:" 
on page 2-6.

Table 2–61 GSM FSIS, USDA HACCP Category key fields

Name Description

Name Name of the USDA HACCP category

Status The assigned status for the USDA HACCP category. Refer to 
"Statuses" on page 2-3 for status descriptions.
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New Product Development Data

Brands - (NPD)
Use the Brands - (NPD) list in ADMN to maintain the data, as Figure 2–83 shows.

Figure 2–83 Brands - (NPD) list

Key Fields

Editing Rules
For instructions on editing the Brands - (NPD) list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–62 NPD, Brands - (NPD) key fields

Name Description

Name Name of the brand in NPD

Status The assigned status for the brand. Refer to "Statuses" on page 2-3 
for status descriptions.
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Business Units - (NPD)
Use the Business Units - (NPD) tree list in ADMN to maintain the data, as Figure 2–84 
shows.

Figure 2–84 Business Units - (NPD) tree list

Editing Rules
For instructions on editing the Business Units - (NPD) tree list, see "Maintaining Tree 
Lists" on page 2-9.
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Channels
Channels are used to define distribution strategies in projects and strategic briefs. Use 
the Channels list in ADMN to maintain the data, as Figure 2–85 shows.

Figure 2–85 Channels list

Key Fields

Editing Rules
For instructions on editing the Channels list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–63 NPD, Channels key fields

Name Description

Name Name of the channel

Status The assigned status for the channel. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Consumer Value Perception
Use the Consumer Value Perception list in ADMN to maintain the data, as Figure 2–86 
shows.

Figure 2–86 Consumer Value Perception list

Key Fields

Editing Rules
For instructions on editing the Consumer Value Perception list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–64 NPD, Consumer Value Perception key fields

Name Description

Name Name of the consumer value perception

Status The assigned status for the consumer value perception. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Demographic Categories
Demographics are used when defining projects and strategic briefs. Use the 
Demographics list in ADMN to maintain the data, as Figure 2–87 shows.

Figure 2–87 Demographics list

Key Fields

Editing Rules
For instructions on editing the Demographics list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–65 NPD, Demographics key fields

Name Description

Name Name of the demographic category.

Status The assigned status for the demographic category. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Document Status
Use the Document Status list in ADMN to o maintain the NPD supporting document 
status list, as Figure 2–87 shows.

Figure 2–88 Document Status list

Key Fields

Editing Rules
For instructions on editing the Document Status list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–66 NPD, Document Status key fields

Name Description

Name Name of the document status.

Behavior ID The document status ID

Default Indicates the default document status

Status The assigned status for the document status. Refer to "Statuses" 
on page 2-3 for status descriptions.



New Product Development Data

2-92 Agile Product Lifecycle Management for Process Administrator User Guide

Document Type
Use the Document Type list in ADMN to maintain document type options for NPD 
supporting documents, as Figure 2–87 shows.

Figure 2–89 Document Type list

Key Fields

Editing Rules
For instructions on editing the Document Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–67 NPD, Document Type key fields

Name Description

Name Name of the document type.

Behavior ID The unique behavior ID that is defined by the system.

Status The assigned status for the document type. Refer to "Statuses" on 
page 2-3 for status descriptions.

Object Type > Object 
Subtype

Select the object and or object subtype where you would like the 
item to appear. For example, if you select Project > Project 
Template the item is only available for selection when the object 
type is a Project and the sub type is "Project Template".
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Enabling Technology
Use the Enabling Technology list to maintain the data, as Figure 2–90 shows.

Figure 2–90 Enabling Technology list

Key Fields

Editing Rules
For instructions on editing the Enabling Technology list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–68 NPD, Enabling Technology key fields

Name Description

Name Name of the enabling technology

Status The assigned status for the enabling technology. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Functional Area - (NPD)
Use the Functional Area - (NPD) list in ADMN to maintain the data, as Figure 2–91 
shows.

Figure 2–91 Functional Area - (NPD) list 

Key Fields

Editing Rules
For instructions on editing the Functional Area - (NPD) list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–69 NPD, Functional Area - (NPD) key fields

Name Description

Available In The NPD business unit that the functional area is available in. 
This is a required field.

Name Name of the functional area.

Status The assigned status for the enabling technology. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Global Categories
Use the Global Categories list in ADMN to maintain the data, as Figure 2–92 shows.

Figure 2–92 Global Categories list

Key Fields

Editing Rules
For instructions on editing the Global Categories list, see "Maintaining Simple Lists" 
on page 2-4.

Table 2–70 NPD, Global Categories key fields

Name Description

Name Name of the global category

Status The assigned status for the global category. Refer to"Statuses" on 
page 2-3 for status descriptions.



New Product Development Data

2-96 Agile Product Lifecycle Management for Process Administrator User Guide

Metrics - Basis
Use the Metrics - Basis list to maintain the data, as Figure 2–93 shows.

Figure 2–93 Metrics - Basis list

Key Fields

Editing Rules
For instructions on editing the Metrics - Basis list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–71 NPD, Metrics - Basis key fields

Name Description

Name Name of the metrics basis

Description Description of the metrics basis

Code Alphanumeric code assigned to the metrics basis

Status The assigned status for the metrics basis. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Metrics - Category
Use the Metrics - Category list to maintain the data, as Figure 2–94 shows.

Figure 2–94 Metrics - Category list

Key Fields

Editing Rules
For instructions on editing the Metrics - Category list, see "Maintaining Simple Lists" 
on page 2-4.

Table 2–72 NPD, Metrics - Category key fields

Name Description

Name Name of the metrics category

Status The assigned status for the metrics category. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Metrics - Fiscal Year
Use the Metrics - Fiscal Year list to maintain the data, as Figure 2–95 shows.

Figure 2–95 Metrics - Fiscal Year list

Key Fields

Editing Rules
For instructions on editing the Metrics - Fiscal Year list, see "Maintaining Simple Lists" 
on page 2-4.

Table 2–73 NPD, Metrics - Fiscal Year key fields

Name Description

Name Name of the metrics fiscal year

Description Description of the metrics fiscal year

Code Alphanumeric code assigned to the metrics fiscal year

Status The assigned status for the fiscal year. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Metrics - Phase
Use the Metrics - Phase list to maintain the data, as Figure 2–96 shows.

Figure 2–96 Metrics - Phase list

Key Fields

Editing Rules
For instructions on editing the Metrics - Phase list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–74 NPD, Metrics - Phase key fields

Name Description

Name Name of the metrics phase

Description Description of the metrics phase

Code Alphanumeric code assigned to the metrics phase

Status The assigned status for the metrics phase. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Priorities
Use the Priorities list in ADMN to maintain the data, as Figure 2–97 shows. 

Figure 2–97 Priorities list

Key Fields

Editing Rules
For instructions on editing the Priorities list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–75 Priorities key fields

Name Description

Name Name of the priority

Status The assigned status for the priority. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Project Type Categories
Use the Project Type Categories tree list in ADMN to maintain the data, as Figure 2–98 
shows.

Figure 2–98 NPD Project Type Categories list

Editing Rules
For instructions on editing the Project Type Categories list, see "Maintaining Tree Lists" 
on page 2-9.
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Project Types
Use the Project Types list in ADMN to maintain the data, as Figure 2–99 shows.

Figure 2–99 Project Types list

Key Fields

Editing Rules
For instructions on editing the Project Types list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–76 NPD, Project Types key fields

Name Description

Available In Category that the project type is available in

Name Name of the project type
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Project Visibilities
Use the Project Visibility list in ADMN to maintain the data, as Figure 2–100 shows.

Figure 2–100 Project Visibility list

Key Fields

Editing Rules
For instructions on editing the Project Visibility list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–77 NPD, Project Visibility key fields

Name Description

Name Name of the project visibility

Status The assigned status for the project visibility. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Risk
Use the Risk list in ADMN to maintain the data, as Figure 2–101 shows. 

Figure 2–101 Risk list

Key Fields

Editing Rules
For instructions on editing the Risk list, see "Maintaining Simple Lists" on page 2-4.

Table 2–78 Risk key fields

Name Description

Name Name of the risk

Status The assigned status for the risk. Refer to "Statuses" on page 2-3 
for status descriptions.
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Product Quality Management Data
Using the ADMN application, you can modify certain Product Quality Management 
(PQM) data. 

Action Type
Use the Action Type list in ADMN to maintain action types for PQM, as Figure 2–102 
shows.

Figure 2–102 Action Type list

Key Fields

Editing Rules
For instructions on editing the Action Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–79 PQM, Action Type key fields

Name Description

Name Name of the action type

Abbreviation Abbreviation for the action type

System Code The system type assigned to the action type. This system type 
controls which core fields are displayed to the user when this 
type is selected. Only one system type of actions is available: 
Corrective and Preventative Action.

Status The assigned status for the action type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Audit Result
Use the Audit Result list in ADMN to maintain audit results for PQM, as Figure 2–103 
shows.

Figure 2–103 Audit Result list

Key Fields

Editing Rules
For instructions on editing the Audit Result list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–80 PQM, Audit Result key fields

Name Description

Name Name of the audit result

External Id Unique identification for the audit result

Status The assigned status for the audit result. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Audit Type
Use the Audit Type list in ADMN to maintain audit types for PQM, as Figure 2–104 
shows.

Figure 2–104 Audit Type list

Key Fields

Editing Rules
For instructions on editing the Audit Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–81 PQM, Audit Type key fields

Name Description

Name Name of the audit type

Abbreviation Abbreviation for the audit type

System Code The system type assigned to the audit type. This system type 
controls which core fields are displayed to the user when this 
type is selected. Only one system type of Audit is available: 
Audit.

Status The assigned status for the audit type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Customers
Use the Customers list in ADMN to maintain customers for PQM, as Figure 2–105 
shows.

Figure 2–105 Customers list

Key Fields

Editing Rules
For instructions on editing the Customers list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–82 PQM, Customers key fields

Name Description

Name Name of the customer

External Id Unique identification for the customer

Status The assigned status for the customer. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Document Status
Use the Document Status list in ADMN to maintain the PQM supporting document 
status list, as Figure 2–105 shows.

Figure 2–106 Document Status list

Key Fields

Editing Rules
For instructions on editing the Document Status list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–83 PQM, Document Status key fields

Name Description

Name Name of the document status.

Behavior ID The document status ID

Default Indicates the default document status

Status The assigned status for the document status. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Document Type
Use the Document Type list in ADMN to maintain document type options for PQM 
supporting documents, as Figure 2–107 shows.

Figure 2–107 Document Type list

Key Fields

Editing Rules
For instructions on editing the Document Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–84 PQM, Document Type key fields

Name Description

Name Name of the document type.

Behavior ID The unique behavior ID that is defined by the system.

Status The assigned status for the document type. Refer to "Statuses" on 
page 2-3 for status descriptions.

Object Type > Object 
Subtype

Select the object and or object subtype where you would like the 
item to appear. For example, if you select Actions, the item is 
only available for selection when the object type is an Action.
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Failure Type
Use the Failure Type list in ADMN to maintain failure types for PQM, as Figure 2–108 
shows. Failure types are associated to an affected item on an issue, action or audit. 

Figure 2–108 Failure Type list

Key Fields

Editing Rules
For instructions on editing the Failure Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–85 PQM, Failure Type key fields

Name Description

Name Name of the failure type

External Id Unique identification for the failure type

Status The assigned status for the failure type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Issue Types
Use the Issue Type list in ADMN to maintain issue types for PQM, as Figure 2–109 
shows.

Figure 2–109 Issue Type list

Key Fields

Figure 2–110 Affected Items grid

Editing Rules
For instructions on editing the Issue Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–86 PQM, Issue Type key fields

Name Description

Name Name of the issue type

Abbreviation Abbreviation for the issue type

System Code The system type assigned to the issue type. This system type 
controls which core fields are displayed to the user when this 
type is selected. Only two system types of Issues are available: 
Problem Report and Non Conformance Report. Non 
Conformance Reports contain extra fields. These fields are 

shown by selecting the non conformance icon ( ) in the 
Affected Items grid. See Figure 2–110 below.

Status The assigned status for the issue type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Product Line
Use the Product Line list in ADMN to maintain product lines for PQM, as Figure 2–111 
shows.

Figure 2–111 Product Line list

Key Fields

Editing Rules
For instructions on editing the Product Line list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–87 PQM, Product Line key fields

Name Description

Name Name of the product line

External Id Unique identification for the product line

Status The assigned status for the product line. Refer to "Statuses" on 
page 2-3 for status descriptions.



Product Quality Management Data

2-114 Agile Product Lifecycle Management for Process Administrator User Guide

Resolution
Use the Resolution list in ADMN to maintain resolutions for PQM, as Figure 2–112 
shows. This list controls the resolution options found on a PQM issue.

Figure 2–112 Resolution list

Key Fields

Editing Rules
For instructions on editing the Resolution list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–88 PQM, Resolution key fields

Name Description

Name Name of the resolution

External Id Unique identification for the resolution

Status The assigned status for the resolution. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Severity
Use the Severity list in ADMN to maintain severities for PQM, as Figure 2–113 shows.

Figure 2–113 Severity list

Key Fields

Editing Rules
For instructions on editing the Severity list, see "Maintaining Simple Lists" on page 2-4.

Table 2–89 PQM, Severity key fields

Name Description

Name Name of the severity

External Id Unique identification for the severity

Status The assigned status for the severity. Refer to "Statuses" on 
page 2-3 for status descriptions.



Product Quality Scorecard Data

2-116 Agile Product Lifecycle Management for Process Administrator User Guide

Product Quality Scorecard Data
Using the ADMN application, you can modify certain Product Quality Scorecard 
(PQS) data. 

Lot Samples Quantity UOMs
Use the Lot Samples Quantity UOMs list in ADMN to maintain units of measure for 
lot sample quantities, as Figure 2–114 shows.

Figure 2–114 Lot Samples Quantity UOMs list

Key Fields

Editing Rules
For instructions on editing the Lot Samples Quantity UOMs list, see "Maintaining 
Simple Lists" on page 2-4.

Reordering Lot Samples Quantity UOMs  

Only users with the role of [SUPER_DATA_ADMIN] can reorder lot sample quantity 
UOMs. For instructions on setting the order, see "To reorder data in a simple list:" on 
page 2-6.

Table 2–90 PQS, Lot Samples Quantity UOMs key fields

Name Description

Name Name of the lot sample quantity unit of measure

Status The assigned status for the lot sample quantity unit of measure. 
Refer to "Statuses" on page 2-3 for status descriptions.
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Sample Types
Use the Sample Type list in ADMN to maintain sample types, as Figure 2–115 shows.

Figure 2–115 Sample Type list

Key Fields

Editing Rules
For instructions on editing the Sample Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–91 PQS, Sample Type key fields

Name Description

Name Name of the sample type

ID Unique identification assigned to the sample type

Status The assigned status for the sample type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Scorecard Qualifications
Use the Scorecard Qualifications list in ADMN to maintain scorecard qualifications, as 
Figure 2–116 shows.

Figure 2–116 Scorecard Qualifications list

Key Fields

Editing Rules
For instructions on editing the Scorecard Qualifications list, see "Maintaining Simple 
Lists" on page 2-4.

Reordering Scorecard Qualifications  

Only users with the role of [SUPER_DATA_ADMIN] can reorder scorecard 
qualifications. For instructions on setting the order, see "To reorder data in a simple 
list:" on page 2-6.

Table 2–92 PQS, Scorecard Qualifications key fields

Name Description

Name Name of the scorecard qualification

Status The assigned status for the scorecard qualification. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Supply Chain Relationship Management Data
Using the ADMN application, you can modify certain Supply Chain Relationship 
Management (SCRM) data. 

Business Units - (SCRM) 
Use the Business Units - (SCRM) tree list in ADMN to maintain the data, as 
Figure 2–117 shows.

Figure 2–117 Business Units - (SCRM) tree list

Editing Rules
Use the instructions provided for editing tree lists provided in "Maintaining Tree Lists" 
on page 2-9.
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Class
Use the Class list in ADMN to maintain the data, as Figure 2–118 shows.

Figure 2–118 Class list

Key Field

Editing Rules
For instructions on editing the Class list, refer to "Maintaining Simple Lists" on 
page 2-4.

Reordering Classes  

Only users with the role of [SUPER_DATA_ADMIN] can reorder classes. For 
instructions on setting the order, see "To reorder data in a simple list:" on page 2-6.

Table 2–93 SCRM, Class key field

Name Description

Name Name of the class

Status The assigned status for the class. Refer to "Statuses" on page 2-3 
for status descriptions.
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Company Special Attributes
Use the Company Special Attributes list in ADMN to maintain the data, as 
Figure 2–119 shows.

Figure 2–119 Company Special Attributes list

Key Field

Editing Rules
For instructions on editing the Company Special Attributes list, see "Maintaining 
Simple Lists" on page 2-4.

Table 2–94 SCRM, Company Special Attributes key field

Name Description

Name Name of the special attribute for companies

Status The assigned status for the special attribute for companies. Refer 
to "Statuses" on page 2-3 for status descriptions.
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Contact Category
Contact categories for company and facility profiles are maintained in the ADMN 
Contact Category list, as Figure 2–120 shows.

Figure 2–120 Contact Category list

Key Field

Editing Rules
For instructions on editing the Contact Category list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–95 SCRM, Contact Category key field

Name Description

Name Name of the contact category

Status The assigned status for the contact category. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Contact Profile Tags
Use the Contact Profile Tags list in ADMN to maintain contact profile tags, as 
Figure 2–12 shows.

Figure 2–121 Contact Profile Tags list

Key Fields

Editing Rules
For instructions on editing the Contact Profile Tag list, see "Maintaining Simple Lists" 
on page 2-4. 

Table 2–96 SCRM Data, Contact Profile Tags key fields

Name Description

Name The contact profile tag name

Type The type of contact profile tag

Behavior ID The system-assigned contact profile tag ID

Status The assigned status for the contact profile tag. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Document Status
Use the Document Status list in ADMN to maintain the SCRM supporting document 
status list, as Figure 2–122 shows.

Figure 2–122 Document Status list

Key Fields

Editing Rules
For instructions on editing the Document Status list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–97 SCRM, Document Status key fields

Name Description

Name Name of the document status.

Behavior ID The document status ID

Default Indicates the default document status

Status The assigned status for the document status. Refer to "Statuses" 
on page 2-3 for status descriptions.
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Document Type
Use the Document Type list in ADMN to maintain document type options for SCRM 
supporting documents, as Figure 2–123 shows.

Figure 2–123 Document Type list

Key Fields

Editing Rules
For instructions on editing the Document Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–98 SCRM, Document Type key fields

Name Description

Name Name of the document type.

Behavior ID The unique behavior ID that is defined by the system.

Status The assigned status for the document type. Refer to "Statuses" on 
page 2-3 for status descriptions.

Object Type > Object 
Subtype

Select the object and or object subtype where you would like the 
item to appear. For example, if you select Company Profile > 
Specification Related Sourcing Approval, the item is only 
available for selection when the object type is a Company Profile 
and the sub type is "Specification Related Sourcing Approval.
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Facility Special Attributes
Use the Facility Special Attributes list in ADMN to maintain the data, as Figure 2–124 
shows:

Figure 2–124 Facility Special Attributes list

Key Fields

Editing Rules
For instructions on editing the Facility Special Attributes list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–99 SCRM, Facility Special Attributes key fields

Name Description

Name Name of the facility special attribute

Status The assigned status for the facility special attribute. Refer to 
"Statuses" on page 2-3 for status descriptions.
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Protocol
Use the Protocol list in ADMN to maintain the data, as Figure 2–125 shows.

Figure 2–125 Protocol list

Key Field

Editing Rules
For instructions on editing the Protocol list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–100 SCRM, Protocol key fields

Name Description

Name Name of the protocol

Status The assigned status for the protocol. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Sourcing Type
Use the Sourcing Type list in ADMN to maintain the data, as Figure 2–126 shows.

Figure 2–126 Sourcing Type list

Key Field

Editing Rules
For instructions on editing the Sourcing Type list, see "Maintaining Simple Lists" on 
page 2-4.

Table 2–101 SCRM, Sourcing Type key field

Name Description

Name Name of the sourcing type

Status The assigned status for the sourcing type. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Workflow Administration Data
Using the ADMN application, you can modify Workflow Administration (WFA) 
functional areas and system actions. 

Functional Area - (WFA)
The Functional Area - (WFA) list is used when evaluating workflow participants in 
WFA. Global Specification Management (GSM), Supply Chain Relationship 
Management (SCRM), and Product Quality Management (PQM) organize workflow 
participant selection by functional area. Functional areas are defined according to the 
needs of each customer. Functional areas may be divided according to company 
departments (Human Resources, Marketing, Sales, and so on). Use the Functional 
Area list in ADMN to maintain the data, as Figure 2–127 shows.

Figure 2–127 Functional Area - (WFA) list

Key Field

Editing Rules
For instructions on editing the Functional Area - WFA list, see "Maintaining Simple 
Lists" on page 2-4.

Table 2–102 WFA, Functional Area - (WFA) key fields

Name Description

Name Name of the functional area in WFA

Status The assigned status for the functional area. Refer to "Statuses" on 
page 2-3 for status descriptions.
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Tags
Global Specification Management (GSM), Supply Chain Relationship Management 
(SCRM), and Product Quality Management (PQM) workflow templates use tags as 
part of defining steps in workflows. Use the Tags list in ADMN to maintain the data, 
as Figure 2–128 shows.

Figure 2–128 Tags list

Key Fields

Table 2–103 WFA, Tags key fields

Name Description

Name Name of the tag

Type Type of tags are as follows: 

Workflow Action—Tags in this group apply to general actions 
that should happen when the specification reaches a certain 
status. For example, Hide Specs flags the specification as hidden, 
so the specification does not appear in search results for all 
users. Other workflow actions include tags that are used by 
outside systems. For example, IsApproved is used signify that 
the specification must be in an "Approved" status to kick off 
integration processes.

Feature —Tags in this group apply to specific feature behavior.   
For example, when the designable tag is present in a formulation 
specification’s workflow, certain design tools appear within the 
UI.

Supplier Action—Tags in this group apply to specific supplier 
related actions that should happen when the specification 
reaches a certain status. For example, Publish to Supplier Portal 
is used when the specification should be available to suppliers. 

Visibility—Tags in this group are used to specify visibility rules. 
Visibility tags are used to filter specifications from search results 
in GSM. See the WFA chapters of the Agile Product Lifecycle 
Management for Process Workflow Administration User Guide to 
learn more about visibility tags. Additional information can be 
found in the Agile Product Lifecycle Management for Process 
Security Configuration Guide.

Behavior ID The unique behavior ID that is defined by the system.
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Editing Rules
For instructions on editing the Tags list, see "Maintaining Simple Lists" on page 2-4.

IsDistinct If a tag is flagged as Is Distinct, the tag can only be applied to 
one Active workflow step per WFA workflow template.

Available In Select which WFA templates these tags should be available in. 
Options are GSM WFA templates and/or SCRM WFA templates 
and/or PQM WFA templates. Note: Visibility tags are not 
supported in SCRM.

Status The assigned status for the tag. Refer to "Statuses" on page 2-3 
for status descriptions.

Table 2–103 WFA, Tags key fields

Name Description
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Spec Category
A specification category is a hierarchy used to group Global Specification Management 
(GSM) specifications. To edit a specification category in ADMN, select the specification 
category by clicking ADMN > Spec Category > {name of specification} from the left 
navigation panel. Specification categories exist for the following specification types: 

Figure 2–129 Selected specification category (Delivered Material Packing Specifications)

Using the ADMN application, you can modify these specification categories, as 
explained in the following sections. The procedure is the same for all specification 
categories. 

Node Statuses
Like other tree lists, specification category nodes contain an icon indicating their 
status:

■ ( )—Active item

■ ( )—New item

■ ( )—Inactive item

■ ( )—Archived item

Editing Specification Categories
For information on adding and editing specification categories, see "Editing Actions" 
on page 2-10. Depending on your configuration, some lists may be controlled by 
another specification category. These lists are called referenced lists. If you select a 

■ Delivered material packing specifications ■ Equipment specifications

■ Formulation specifications ■ Labeling specifications

■ Master specifications ■ Material specifications

■ Menu item specifications ■ Nutrient profiles

■ Packaging material specifications ■ Packing configuration specifications

■ Printed packaging specifications ■ Product specifications

■ Trade specifications

Note: When the specification category is consumed in other 
applications, the displayed specification category is limited to 200 
characters for all three levels combined.
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referenced list, Agile PLM for Process displays an information message, shown in 
Figure 2–130.

Figure 2–130 Referenced list redirect message

Parent-Child Relationship Guidelines
Use the following guidelines when working with specification categories:

■ Relationship rules between the states of parents and children within a specification 
category must be respected. Once a node as been activated it must remain in the 
same level of the hierarchy. For example, if the node is a third level position, it can 
only be dragged to another third level position. If you attempt to drag an item to a 
location that disrupts the hierarchy, an error message displays, as Figure 2–131 
shows:

Figure 2–131 Drag and drop warning

As an administrator, you have the ability to reorganize categories and add items to 
categories. Users with the role [SUPER_DATA_ADMIN] can drag and drop items 
regardless of the item’s status. Users with the role [DATA_ADMIN] can drag and drop 
new items only.

A parent node in an "Inactive" or "Archived" state must have all child nodes in an 
"Inactive" or "Archived" state. When you inactivate or archive a node, it’s child nodes 
are automatically inactivated or archived as well.

■ You can move an active node only to another node with a status of "Active." If you 
attempt to move an active node to an inactive or archived node, the error message 
shown in Figure 2–132 displays. 

Figure 2–132 Active node movement to non-active node warning 

Warning: All specification categories must have three active levels 
as indicated by the active node symbol ( ). 
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Activities
The import/export activities include "tokens" as a synchronization tool that allows you 
to import/export multiple types of data between the staging and target environments. 
The process is reliant on a "staging/target" relationship. There is one staging 
environment where data is created or changed, and one to many target environments 
(Production, Testing, QA). 

Generate Token
"Token Section" on page 2-135 explains how tokens are used for exporting data. 

To generate a token:

1. Log in to the target environment.

2. Access the ADMN application in the left navigation panel.

3. Click Activities > Generate Token on the left navigation panel. ADMN displays 
the Generate Token page, as Figure 2–133 shows.

Figure 2–133 Generate Token page

4. Click Generate. A File Download dialog box displays the token file name.

5. In the File Download dialog box, click Save.

6. Navigate to the local folder to store the token.

7. In the Save As dialog box, click Save.

Note: The environment names and position in the process are set in 
the configuration files.

Warning: The file extension for the token must be.tok
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Export
You can export data from a centralized export page in the staging environment. A user 
can access the page by selecting ADMN > Activities > Export from the left navigation 
panel or by clicking Export at the top of each individual data type page. The Export 
page, shown in Figure 2–134, contains fields for uploading a token from a target 
environment and a drop-down list to select data types. 

Figure 2–134 Export page

Token Section
Tokens are generated from a target environment. If there are multiple target 
environments, each one must generate its own token for import. Tokens help the 
system decide which data to include in the export package. 

Update Token—Tokens must be uploaded into the staging environment before a data 
type can be packaged for export. Use this field to select a token.

To upload a token:

1. Click Browse. A dialog box displays.

2. Select the token to upload. 

3. Click Open. The file you selected displays in the Update Token field.

4. Click Upload Token to upload the token. The token, once uploaded, displays the 
target environment name and the date that the token was generated.

Note: A new token should be generated when the data in your target 
environment has changed.

Note: The file extension for the token must be .tok
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Export Data Section
Select the data to package and export using this section.

Data—This drop-down list contains each export data type. Each selected data type 
creates an export package. The package is an encrypted file that contains the exported 
data.

To export data from a staging environment into the target environment:

1. Log in to the staging environment and generate a token as explained in "To 
generate a token:" on page 2-134.

2. Log in to the staging environment.

3. Access the ADMN application in the left navigation panel.

4. Click Activities > Export in the ADMN left navigation panel. The Export page 
displays.

5. Click Browse to locate the folder that contains the token.

6. Navigate to the folder that contains the token.

7. Click Open and then click Upload Token.

8. Select the data types from the Data drop-down list.

9. Click Export. A dialog box displays with the file name of the export package. 

10. Click Save.

11. Navigate to a local folder to store the export packages.

12. Click Save again.

13. Repeat steps 5 through 12 for as many data types as needed.

Import
You import data from a centralized import page in a target environment. You can 
access the import page from selecting ADMN > Activities > Import from the left 
navigation panel. Figure 2–135 shows the Import page. 
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Figure 2–135 Import page

Initiate Import Section
Select and name a file to import using this section.

File—Click the Browse button to locate your export package.

Description—Provide a description in this text field.

Click Schedule Import to schedule the import. The file you selected displays in the 
table in the Import Queue section.

Import Queue Section
This section contains a table showing imports that are queued. The table contains the 
following fields:

■ Name—The package name

■ Description—The package description

■ Submitted By—The name of the user who submitted the package

■ Date Submitted—The date that the package was submitted

■ Date Completed—The date that the import was completed

■ Status—A green, amber or red status icon. The green icon indicates "Completed." 
The amber icon indicates "In Progress." The red icon indicates "Not Imported." 
"Not Imported" indicates that there was an error during import. The red status 
icon links to the error. Once a package is imported, the system emails the person 
who scheduled the import and flushes the associated cache group.

Click the delete icon to delete an import package’s reference in the queue. This action 
does not cancel the import; it only removes the record in the queue.

To import data into your target environment:

1. Log in to your production environment.
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2. Access the ADMN application in the left navigation panel.

3. Click Activities > Import in the left navigation panel.

4. Click Browse to locate the export package that you exported from the staging 
environment and select the file.

5. Click Open.

6. Enter a description for the export package.

7. Click Schedule Import. The package is added to the import queue.

8. Repeat Steps 4-7 to add more export packages to your queue.
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3Using ADMN to Manage Custom Data

This chapter explains how to maintain custom data using the Manage Core Data 
(ADMN) application. Topics in this chapter include: 

■ Introducing Custom Data

■ Extended Attribute Groups

■ Creating or Editing Extended Attribute Groups

■ Extended Attributes

■ Creating an Extended Attribute

■ Setting Extended Attribute Order

■ Custom Sections

■ Creating a Custom Section

■ Creating a Table

■ Previewing a Custom Section

■ Copying a Custom Section

■ Setting Custom Section Order

Introducing Custom Data
Agile Product Lifecycle Management (PLM) for Process administrators use the ADMN 
(Manage Core Data) application to maintain data lists and extended attributes that are 
used across Agile PLM for Process applications. In addition to maintaining core data, 
you can define custom data (customer-specific data). This chapter explains how to 
create and maintain custom data. Chapter 2, "Using ADMN to Manage Core Data", 
explains how to create and maintain core data within Agile PLM for Process.

Custom Data Types
There are two types of custom data that administrators create:

■ Extended attributes—Customer-defined and maintained fields that are available 
on some business objects. Customers use extended attributes to capture custom 
information and elements that are unique to their business. Extended attributes 
can capture textual, numeric, boolean, calculated, date, and range data. 

■ Custom sections—Custom sections are configurable sets of extended attributes. 
Custom sections allow you to organize a group of extended attributes in table 
format. 



Introducing Custom Data

3-2 Agile Product Lifecycle Management for Process Administrator User Guide

The ADMN > Custom Data submenu lists available custom data types, as Figure 3–1 
shows, along with other options:

Figure 3–1 Custom Data menu

Statuses
Custom data contain statuses that are defined as follows:

■ New—The data is not yet ready to become available to Agile PLM for Process 
applications. When an item has a status of "New," its values remain editable.

■ Active—The data is available (searchable and available for assignment) for use in 
Agile PLM for Process applications.

■ Inactive—The data should no longer be used. All existing references to this item 
remain. The item is no longer available for assignment but is still searchable.

■ Archive—The item is no longer available for searching or assignment. All existing 
references to this item remain. 

Administrative Roles  

There are several user roles associated with ADMN:

[DATA_ADMIN]—Can add and edit new items, but edit rights are limited.

[SUPER_DATA_ADMIN]—Can edit most items regardless of the item’s status.

[EA_SECTION_CREATOR]—Can see the Create New and Edit buttons on custom 
sections.

[CUSTOM_SECTION_DENORM_ENABLER]—The user must have this role to 
include a custom section in the de-normalization process. 

[DENORMALIZED_CUSTOM_SECTION_EDITOR]—Once a custom section has 
been activated (status of active, inactive, archived) and is flagged as Include in 
De-normalization a user needs this role to make any edits to the custom section.

If the user doesn’t have this role they will not see the Edit action button and instead 
sees the following information panel message. "This section has been marked for 
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inclusion in the de-normalization process. You do not have the proper privileges to 
edit this Custom Section."

These roles are explained more later in this chapter.

Extended Attribute Groups
Extended attribute groups are used to organize attributes. These groups can be used to 
filter available extended attributes during consumption. For example, when users are 
adding attributes in GSM they can filter the extended attributes list by group name. 
See Figure 3–2 showing the extended attributes dialog box in GSM filtered by the 
group "Label Claims."

Figure 3–2 Extended attributes filtered by “Label Claims” group

An extended attribute cannot be saved unless its been assigned to a group. If you do 
not have any extended attribute groups defined in Agile PLM for Process, you must 
create these prior to creating extended attributes. 
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Creating or Editing Extended Attribute Groups
To create extended attribute groups:

1. Click ADMN > Custom Data > Extended Attribute Groups. Extended attribute 
groups display in the Extended Attribute Groups list, as Figure 3–3 shows:

Figure 3–3 Custom Data, Extended Attribute Groups list

2. Optionally, choose one of the following:

■ Add a new extended attribute group—Click Add in the action menu. A new 
row displays at the top of the Extended Attribute Groups list. Enter the new 
extended attribute group name in the empty text field. Click the apply changes 
icon to apply your change.

■ Edit an existing extended attribute group—Click the edit icon to the left of 
the group name and edit the extended attribute group name in the provided 
text field. Click the apply changes icon to apply your change.

3. Click Save.

4. Flush the administrator data cache, as described in "Using the Cache Application" 
on page 4-3.

Note: Only a user with the role [ADD_EXT_ATT] can add an 
extended attribute group. For more information on roles, see the Agile 
Product Lifecycle Management for Process User Group Management User 
Guide.

Note: Only a user with the role [SUPER_DATA_ADMIN] can edit an 
existing extended attribute group. For more information on roles, see 
the Agile Product Lifecycle Management for Process User Group 
Management User Guide.
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Extended Attributes
You can create new extended attributes using the ADMN application. Extended 
attributes are found in the following objects:

GSM

NPD—Projects, innovations/sales pipelines, activities, and strategic briefs 

PQM—Issues, actions, and audits

SCRM—Companies, facilities, and sourcing approvals

eQ—Material, packaging, printed packaging, product questionnaires, and trade 
questionnaires 

CSS—Publications

Figure 3–4 shows the Extended Attribute Template page. 

■ Activities ■ Packing configuration specifications

■ Equipment specifications ■ Packaging material specifications

■ Formulation specifications ■ Printed packaging specifications

■ Master specifications ■ Product specifications

■ Material specifications ■ Smart Issue requests

■ Menu item specifications ■ Testing protocols

■ Nutrient profiles ■ Trade specifications

■ Output items
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Figure 3–4 Extended Attribute Template page

Summary Tab

Attribute Configuration Section  

Enter the following information in the Attribute Configuration section.

Attribute Name—Name for the extended attribute. This field is required. This value is 
a multi-lingual value. Use the set alternate language text icon to edit or add additional 
language values. This icon is not visible until the attribute is saved. This is the name 
displayed when the attribute is added to the extended attributes section and can also 
be used when searching for extended attributes and custom sections.

Attribute ID—A unique identifier. This is a required field. This ID is used to reference 
the extended attribute during calculations and integrations.

Type—The type of extended attribute. Choices are: Boolean, Calculated Boolean, 
Calculated Numeric, Calculated Text, Date, Free Text, Long Free Text, Long 
Multi-lingual Text, Multi-lingual Text, Numeric, Qualitative, Qualitative Lookup, 
Qualitative Range, and Qualitative Tolerance. These are defined in detail beginning on  
on page 3-8. This is a required field.

Distinct—Select to indicate that this extended attribute is intended to occur only once 
(a single cell instance) within a specification or profile. An attribute must be distinct to 
be rolled up during formulation. This flag cannot be edited once the attribute has been 
activated. If the attribute will be accessed during reporting or integration, it is strongly 
recommended you make the attribute distinct. This flag keeps the attribute unique per 
specification and increases performance when accessing it. 
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Segment(s)—Assign a segment to the extended attribute. This field may not display 
based on configuration settings. 

Available In—Click the link to display a selection dialog box containing a list of areas 
where you can make the attribute available. This field is required.

Class—Class indicates if you plan on using the attribute in a custom section and/or 
the simple extended attribute list. An attribute can be made available to both. This 
field is required. Click the link to display a selection dialog box containing the 
following options:

■ Custom Sections—Makes the attribute available for assignment to a custom 
section. For more information, see "Custom Sections" on page 3-33. 

■ Simple—Makes the attribute available to the extended attribute lists.

Tags—Tags allow you to apply special behaviors to your attribute. Multiple tags can 
be attached to an attribute. Click the link to display a selection dialog box containing 
the following options:

■ Bold—Extended attribute is bolded anywhere it appears in consumption. 

■ Do Not Publish to Supplier—Extended attribute is not published to Supplier 
Portal and is unavailable in eQuestionnaire.

■ ERP_Owner—This tag is legacy data from AIA and is used to publish values 
from PLM for Process to EBS system via PIP.

■ ERP_Owning_Org—This tag is legacy data from AIA and is used to publish 
values from PLM for Process to EBS system via PIP.

■ Is Design Attribute—Extended attribute is automatically added to a 
formulation output item. This happens when the attribute is marked as 
distinct and present on one of the formulation inputs. This is a usability helper 
only, keeping the user from having to manually add attributes to the 
formulation output item. This tag does not control roll ups.

■ Is Distinct—This tag is legacy data from AIA and is used to publish values 
from PLM for Process to EBS system via PIP.

■ IS_ERP_ENGINEERING_ITEM—This tag is legacy data from AIA and is 
used to publish values from PLM for Process to EBS system via PIP.

■ Italic—Extended attribute is italicized anywhere it appears in consumption.

■ Suppress Printing—Extended attribute is not included in the specification 
print out.

Category Tabs—Click the link to display a selection dialog box containing a list of 
extended attribute category tabs.

Groups—Click the link to display a selection dialog box containing a list of extended 
attribute groups, as defined in "Extended Attribute Groups" on page 3-3. Attributes 
can be added to multiple groups. This is a required field.

Status—Click the drop-down list to assign a status to the extended attribute with one 
of the following: 

Note: eQuestionnaire extended attribute availability is based on the 
related GSM specification type. For example, when creating a material 
questionnaire you are only allowed to add attributes that are available 
in material specifications.
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■ New—The extended attribute is not yet ready to become available to Agile 
PLM for Process applications. When an extended attribute has a status of 
"new", its values remain editable.

■ Active—The extended attribute is ready to become available for use in Agile 
PLM for Process applications. 

■ Inactive—The extended attribute should no longer be used. Inactive extended 
attributes are no longer available for assignment, however, they are not 
removed from existing objects that reference them. Inactive extended 
attributes are still available for searching.

■ Archived—The extended attribute is not available for searching or 
assignment. Archived extended attributes are not removed from existing 
objects that reference them.

Security Classification—This field is only available if Object Level Security is enabled. 
A classification can be used to limit access to the extended attribute in Agile PLM for 
Process applications. Refer to the Agile Product Lifecycle Management for Process Security 
Configuration Guide for more information.

Type  

Use the Type field to assign a type to the extended attribute. This is a required field. 
The type of extended attribute decides what interface is displayed to users. For 
example, the "Free Text" type displays a text area to the user. The choice you make in 
the type field determines which additional options display under it. The type cannot 
be changed once the attribute is activated.

Select one of the following choices for the Type field. These are defined further on the 
following pages.

Date  This type allows the user to enter a date, as Figure 3–5 shows. The user will be 
provided a calendar control to help select the appropriate date, as Figure 3–6 shows.

Figure 3–5 Type field, Date

■ Boolean ■ Calculated Boolean ■ Calculated Numeric

■ Calculated Text ■ Date ■ Free Text

■ Long Free Text ■ Long Multi-lingual Text ■ Multi-lingual Text

■ Numeric ■ Qualitative ■ Qualitative Lookup

■ Quantitative Range ■ Quantitative Tolerance
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Figure 3–6 Date extended attribute

Free Text  This type allows the user to enter free text, as Figure 3–7 shows. By default 
this style appears as a text field. Check the Multi-line box to make it a multi-line text 
area. Figure 3–8 shows an example of what the user might see. 

Figure 3–7 Type field, Free Text

Figure 3–8 Free text extended attribute (multi-line)
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Long Free Text   This type allows the user to enter long free text, as Figure 3–9 shows. By 
default this style appears as a text field. Check the Multi-line box to make it a 
multi-line text area. Figure 3–10 shows an example of what the user might see. 

Figure 3–9 Type field, Long Free Text

Figure 3–10 Long free text extended attribute

Long Multi-lingual Text   This type allows the user to enter long multi-lingual text, as 
Figure 3–11 shows. By default this style appears as a text field. Check the Multi-line 
box to make it a multi-line text area. Figure 3–12 shows an example of what the user 
might see. 

Figure 3–11 Type field, Long Multi-lingual Text
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Figure 3–12 Long multi-lingual text extended attribute

Multi-lingual Text   This type allows the user to enter multi-lingual text, as Figure 3–13 
shows. By default this style appears as a text field. Check the Multi-line box to make it 
a multi-line text area. Figure 3–14 shows an example of what the user might see. 

Figure 3–13 Type field, Multi-lingual Text

Figure 3–14 Multi-lingual text extended attribute
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Numeric   Provide a numeric field for the extended attribute, as Figure 3–15 shows.

Figure 3–15 Type field, Numeric

Figure 3–16 shows what this type looks like when assigned.

Figure 3–16 Numeric extended attribute

Additional options associated with this type are:

UOM Category—Select the unit of measure category that you want to include with 
your numeric field (for example, "Length," "Mass," "Time," and "Volume"). The UOMs 
in the category of "Other" can be extended by editing the UOM list discussed on 
page 2-39. Select "None" to not display a UOM option next to the numeric field.

Available UOMs—Choose the unit of measure options that you want to be available 
to the user.

Default UOM—Set the unit of measure that is selected by default. Your choices are 
derived from your selections made in the Available UOMs field. If no default UOM is 
specified, '---' is selected as the default. A blank selection is allowed.

Decimal Precision—Set the decimal precision as follows:

■ As Entered—The user entered value is not altered.

■ Specified Precision—The user entered value is altered to match the specified 
number of decimal places. If the user does not include the specified number of 
decimals, zeros are appended to the value. If the user exceeds the number of 
decimals, the value is rounded. For example, if the specified number is "1" and 
the user enters "1.58," when the row is submitted the value is altered to "1.6."
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Quantitative Range  Provide a quantitative range of fields for the extended attribute, as 
Figure 3–17 shows.

Figure 3–17 Type field, Quantitative Range

Figure 3–18 shows what this type looks like when assigned.

Figure 3–18 Quantitative range extended attribute

Additional options are:

UOM Category—Select the unit of measure category that you want to include with 
your numeric field (for example, "Length," "Mass," "Time," and "Volume"). The UOMs 
in the category of "Other" can be extended by editing the UOM list discussed on 
page 2-39. Select "None" to not display a UOM option next to the numeric field.

Available UOMs—Choose the unit of measure options that you want to be available 
to the user.

Default UOM—Set the unit of measure that is selected by default. Your choices are 
derived from your selections made in the Available UOMs field. If no default UOM is 
specified, the first UOM in the list is selected as the default. A blank selection is 
allowed.

Decimal Precision—Set the decimal precision as follows:

■ As Entered—The user entered value is not altered.

■ Specified Precision—The user entered value is altered to match the specified 
number of decimal places. If the user does not include the specified number of 
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decimals, zeros are appended to the value. If the user exceeds the number of 
decimals, the value is rounded. For example, if the specified number is “1” 
and the user enters “1.58,” when the row is submitted the value is altered to 
“1.6.”

Range Values—Check the range value of Target, Min, and/or Max. This selection 
determines which fields the user will see.

Quantitative Tolerance  Set up a quantitative tolerance extended attribute to provide 
tolerance fields to the user, as Figure 3–19 shows.

Figure 3–19 Type field, Quantitative Tolerance

Figure 3–20 shows what this type looks like when assigned.

Figure 3–20 Quantitative tolerance extended attribute

Additional options are:

UOM Category—Select the unit of measure category that you want to include with 
your numeric field (for example, "Length," "Mass," "Time," and "Volume"). The UOMs 
in the category of "Other" can be extended by editing the UOM list discussed  on 
page 2-39. Select "None" to not display a UOM option next to the numeric field.

Available UOMs—Choose the unit of measure options that you want to be available 
to the user.

Default UOM—Set the unit of measure that is selected by default. Your choices are 
derived from your selections made in the Available UOMs field. If no default UOM is 
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specified, the first UOM in the list is selected as the default. A blank selection is 
allowed.

Decimal Precision—Set the decimal precision as follows:

■ As Entered—The user-entered value is not altered.

■ Specified Precision—The user entered value is altered to match the specified 
number of decimal places. If the user does not include the specified number of 
decimals, zeros are appended to the value. If the user exceeds the number of 
decimals, the value is rounded. For example, if the specified number is "1" and 
the user enters "1.58," when the row is submitted the value is altered to "1.6."

Qualitative  Set up a qualitative extended attribute to display selectable options to the 
user, as Figure 3–21 shows. 

Figure 3–21 Type field, Qualitative, Checkboxes option

Style—Select the style you want to use to display your attribute options to the user. 
This value is a multi-lingual value. Use the set alternate language text icon to edit or 
add additional language values. This icon is not visible until the attribute is saved. The 
following styles are available:

■ Multi Select - Checkboxes—Display attribute options to the user in the form 
of checkboxes. This style is recommended when you have a small amount of 
options (1-3 items) and you want to give the user the opportunity to select 
multiple options. Figure 3–22 shows how the user will see this style.

Figure 3–22 Checkboxes style

■ Single Select - Pull down—Display attribute options to the user in the form of 
a pull down list. This style is recommended when you have a medium amount 
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of options (3-25) and you want to restrict the user to a single selection. 
Figure 3–23 shows how the user will see this style. 

Figure 3–23 Pull-down style

■ Single Select - Radio buttons—Display attribute options to the user in the 
form of radio buttons. This style is recommended when you have a small 
amount of options (3-20 items) and you want to restrict the user to a single 
selection. Figure 3–24 shows how the user will see this style.

Figure 3–24 Radio buttons style

■ Multi Select - Dialog—Display attribute options to the user in the form of a 
multi-select dialog box. This style is recommended when you have a large 
amount of options (25-100+ items) and you want to give the user the 
opportunity to select multiple options. The multi-select dialog automatically 
sorts your options alphabetically. Figure 3–25 and Figure 3–26 show how the 
user will see this style.

Figure 3–25 Multi-select dialog style

Figure 3–26 Sample multi-select dialog box
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■ Single Select - Dialog—Display attribute options to the user in the form of a 
single-select dialog box. This style is recommended when you have a large 
amount of options (25-100+ items) and you want to restrict the user to a single 
selection. The single-select dialog automatically sorts your options 
alphabetically. Figure 3–27 and Figure 3–28 show how the user will see this 
style.

Figure 3–27 Single select dialog style

Figure 3–28 Sample single-select dialog box

To add options for the Qualitative type:

1. Select "Qualitative" from the Type drop-down list.

2. Select a style from the Style drop-down list. A table displays which you use to 
define the options that are available for the user upon consumption, as Figure 3–29 
shows. 

Figure 3–29 Checkboxes style, Add New

3. Click Add New. The first row opens in edit mode.

4. In the Qualitative Option field, define a value for the option. 

5. In the Status field, select Active. 

6. Click the apply changes icon. 
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7. Repeat step 3 through step 6 to add additional options. Figure 3–30 shows what a 
completed table may look like:

Figure 3–30 Qualitative type, Checkboxes options defined

8. Optionally, click the Order Items button to set the order of item. 

When you click Order Items, ADMN displays the Order Items dialog box:

Figure 3–31 Order Items dialog box - 12/3 Getting Parser Error

a. Use the reorder rows icons to set the order of the items.

b. Click Done. The items reflect the chosen order.

9. Click Save.

Qualitative Lookup   Set up a qualitative lookup extended attribute to create extended 
attributes that reference existing ADMN lists for core fields such as allergens, 
additives, or countries. Most common lookups are available. This type is also used 
when referencing a custom database table. Refer to Agile Product Lifecycle Management 
for Process Data Administration Toolkit Guide for instructions on creating a custom 
qualitative lookup. This attribute will display selectable options to the user, as 
Figure 3–33 through Figure 3–37 show. 

Note: The Order Items button is displayed when user has role 
[SUPER_DATA_ADMIN].

Note: Because of the larger number of items included in the list, the 
single and multi select styles list items alphabetically. This order is 
only respected when using checkboxes, radio buttons, and 
pull-downs.
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Figure 3–32 Type field, Qualitative Lookup

Style—Select the style you want to use to display your attribute options to the user. 
The following styles are available:

■ Multi Select - Checkboxes—Display attribute options to the user in the form 
of checkboxes. This style is recommended when you have a small amount of 
options (1-3 items) and you want to give the user the opportunity to select 
multiple options. Figure 3–33 shows how the user will see this style.

Figure 3–33 Checkboxes style

■ Single Select - Pull down—Display attribute options to the user in the form of a 
pull down list. This style is recommended when you have a medium amount of 
options (3-25) and you want to restrict the user to a single selection. Figure 3–34 
shows how the user will see this style.

Figure 3–34 Pull-down style

■ Single Select - Radio buttons—Display attribute options to the user in the 
form of radio buttons. This style is recommended when you have a small 
amount of options (2-3 items) and you want to restrict the user to a single 
selection. Figure 3–35 shows how the user will see this style.

Figure 3–35 Radio buttons style
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■ Multi Select - Dialog—Display attribute options to the user in the form of a 
multi-select dialog box. This style is recommended when you have a large 
amount of options (25-100+ items) and you want to give the user the 
opportunity to select multiple options. The multi-select dialog automatically 
sorts your options alphabetically. Figure 3–36 shows how the user will see this 
style.

Figure 3–36 Multi select dialog style

■ Single Select - Dialog—Display attribute options to the user in the form of a 
single-select dialog box. This style is recommended when you have a large 
amount of options (25-100+ items) and you want to restrict the user to a single 
selection. The single-select dialog automatically sorts your options 
alphabetically. Figure 3–37 shows how the user will see this style.

Figure 3–37 Single select dialog style

After setting the qualitative lookup style, click the search icon at the end of the 
Category field to set the category for the extended attribute. This category can be an 
existing common lookup category (allergens, additives, etc.) or can be a configured 
custom table. Refer to the Agile Product Lifecycle Management for Process Data 
Administration Toolkit Guide for more information on custom table implementation.

Figure 3–38 shows an example of adding the Lookup Category to the extended 
attribute. In this case you are adding "Allergens".
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Figure 3–38 Example 1: Lookup category added to extended attribute 

Note that the Style must be carefully thought through in order to determine the most 
efficient method for managing data. In this example, we do not recommend using the 
multi-select check boxes functionality for Allergens because the list is so large. Only 
single/multi select dialogs should be used.

Calculated Boolean   Set up Boolean extended attributes in which users are provided a 
True/False drop-down. 
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Figure 3–39 Type field, Calculated Boolean

Figure 3–40 shows what this type looks like assigned. 

Figure 3–40 Calculated Boolean extended attribute

Additional options associated with this type are:

Display Text—Enter text to show before the drop-down. This field is optional. This 
value is a multi-lingual value. Use the set alternate language text icon to edit or add 
additional language values. This icon is not visible until the attribute is saved.

Default State—Select the default state. Options are blank, ’True,’ and ‘False.’

Rollup Behavior—When Boolean attributes are set as distinct and included on 
formulation inputs, they can be rolled up. Define rollup behavior by selecting an 
option from the following drop-down list:

Rollup as true if the following condition is true— 

■ All items are Selected—This option sets the rolled up boolean extended 
attribute value to "True" if all attributes on the formulation input materials are 
set to "True." If any of the attributes are set to "False" the boolean rolls up as 
"False."

■ One item is Selected—This option sets the rolled up boolean extended 
attribute value to "True" if one or more attributes on the formulation input 
materials are set to "True." If this condition is not "True," the boolean rolls up 
as "False."

Behaviors—Check the Allow Nulls box to calculate even when there is no user 
entered value for the referenced items. 
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When a calculation is performed and the system cannot find a referenced item or an 
error occurs, the warning icon appears next to the attribute. Check the Show Error 
Details box when the calculation is not sensitive information. When Show Error 
Details is selected, the end user is able to click the warning icon and see calculation 
error details. These details could include formulation details, referenced variable 
names, etc.

Calculation Script—Click the Calculation Script link to display the calculation dialog 
box for entering a calculation script. See the “Calculated Attributes" section of the Agile 
Product Lifecycle Management for Process Extensibility Guide for help in writing 
calculation scripts. Click Calculate to test your calculation.

Calculated Numeric   Calculated Numerics allow you to create a read-only extended 
attribute that displays results of a calculation to the user. Figure 3–41 shows the 
options available when a calculated numeric type is selected. 

Figure 3–41 Type field, Calculated Numeric

When this type is assigned the user sees a read-only view showing the results of the 
calculation. 

Additional options are:

UOM Category—Select the unit of measure category that you want to include with 
your numeric field (for example, "Length," "Mass," "Time," and "Volume"). The UOMs 

Note: Warnings can be turned off using methods during your 
calculation. For more information, refer to the “Calculated Attributes" 
section of the Agile Product Lifecycle Management for Process Extensibility 
Guide.
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in the category of "Other" can be extended by editing the UOM list discussed on 
page 2-39. Select "None" to not display a UOM option next to the numeric field.

Display UOM—Choose the unit of measure you want to display with the calculated 
attribute.

Default UOM—Set the unit of measure that is selected by default. Your choices are 
derived from your selections made in the Available UOMs field. If no default UOM is 
specified, the first UOM in the list is selected as the default. A blank selection is 
allowed.

Decimal Precision—Set the decimal precision as follows:

■ As Entered—The calculated value is not altered.

■ Specified Precision—The calculated value is altered to match the specified 
number of decimal places. If the calculated value does not include the 
specified number of decimals, zeros are appended to the value. If the 
calculated value exceeds the number of decimals the value is rounded. For 
example, if the specified number is "1" and the user enters "1.58," when the 
row is submitted the value is altered to "1.6."

Behaviors—Check the Allow Nulls box to calculate even when there is no user 
entered value for the referenced items. 

When a calculation is performed and the system cannot find a referenced item or an 
error occurs, the warning icon appears next to the attribute. Check the Show Error 
Details box when the calculation is not sensitive information. When Show Error 
Details is selected, the end user is able to click the warning icon and see calculation 
error details. These details could include formulation details, referenced variable 
names, etc.

Calculation Script—Click the Calculation Script link to display the calculation dialog 
box for entering a calculation script. See the “Calculated Attributes" section of the Agile 
Product Lifecycle Management for Process Extensibility Guide for help in writing 
calculation scripts. Click Calculate to test your calculation.

Calculated Text  This type allows the user to enter calculated free text, as Figure 3–42 
shows. By default this style appears as a text field. Check the Multi-line box to make it 
a multi-line text area. Figure 3–43 shows an example of what the user might see. 

Note: Warnings can be turned off using methods during your 
calculation. For more information, refer to the “Calculated Attributes" 
section of the Agile Product Lifecycle Management for Process Extensibility 
Guide.



Extended Attributes

Using ADMN to Manage Custom Data 3-25

Figure 3–42 Type field, Calculated Text

Figure 3–43 Calculated text extended attribute (multi-line)

Boolean  Set up Boolean extended attributes in which users are provided a True/False 
drop-down.

Figure 3–44 Type field, Boolean

Figure 3–45 shows what this type looks like assigned. 
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Figure 3–45 Boolean extended attribute

Additional options associated with this type are:

Display Text—Enter text to show before the drop-down. This field is optional. This 
value is a multi-lingual value. Use the set alternate language text icon to edit or add 
additional language values. This icon is not visible until the attribute is saved.

Default State—Select the default state. Options are blank, ’True,’ and ‘False.’

Rollup Behavior—When Boolean attributes are set as distinct and included on 
formulation inputs, they can be rolled up. Define rollup behavior by selecting an 
option from the following drop-down list:

Rollup as true if the following condition is true— 

■ All items are Selected—This option sets the rolled up boolean extended 
attribute value to "True" if all attributes on the formulation input materials are 
set to "True." If any of the attributes are set to "False" the boolean rolls up as 
"False."

■ One item is Selected—This option sets the rolled up boolean extended 
attribute value to "True" if one or more attributes on the formulation input 
materials are set to "True." If this condition is not "True," the boolean rolls up 
as "False."
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Creating an Extended Attribute
To create an extended attribute:

1. On the left navigation panel click New > Extended Attributes. ADMN displays 
the Extended Attribute Template page, as shown in Figure 3–46.

Figure 3–46 Extended Attribute Template page

2. Enter extended attribute information, as described in "Summary Tab" on page 3-6 
and "Type" on page 3-8.

3. Click Save & Close.

4. To make the attribute available, flush the extended attributes / custom sections 
cache, as described in "Using the Cache Application" on page 4-3.

Displaying Extended Attributes as Bold or Italic Text
To format an extended attribute, perform the following steps:

1. Create the extended attribute following the same steps as outlined above.

2. Select the bold and/or italics tags, as shown below:
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Figure 3–47 Selecting bold or italic tags

Figure 3–48 shows an extended attribute with the Bold tag applied.

Figure 3–48 Bolded extended attributes

Editing an Extended Attribute
To edit an extended attribute:

1. On the left navigation panel click ADMN > Custom Data > Extended Attributes. 
ADMN displays the Extended Attribute Template Search page.

2. Using the search feature, search for and select the extended attribute to edit. (For 
instructions on the search feature, see "Searching for Extended Attributes" on 
page 3-29.) The Extended Attributes page displays. 

3. In the action menu, click Edit. The Extended Attributes page reloads. Depending 
on your role and the attribute’s status, the screen displays several fields in edit 
mode.
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4. Edit extended attribute information in the Summary tab, as described in 
"Summary Tab" on page 3-6 and "Type" on page 3-8.

5. Click Save & Close.

6. To make your edits available, flush the extended attributes / custom sections 
cache, as described in "Using the Cache Application" on page 4-3.

Searching for Extended Attributes
To search for extended attributes:

1. On the left navigation panel click ADMN > Custom Data > Extended Attributes. 
ADMN displays the Extended Attribute Template search page.

2. Enter search criteria for extended attributes:

a. In the key field drop-down list, select your search criteria as follows:

– -- — Searches for all extended attributes

– Attribute ID—Searches for extended attributes by unique identifier

– Attribute Name—Searches for extended attributes by name

– Available In—Searches for extended attributes according to the 
specification, company/facility profile, publication, testing protocol, NPD 
project, or sourcing approval in which it is used

– Category Tag—Searches for extended attributes by category tab

– Class—Searches for extended attributes by class

– Group—Searches for extended attribute by extended attribute group

– Most Recently Used—Searches for the most recently used extended 
attributes

– Security Classification—Searches for extended attribute by security 
classification.

– Segment (+Children)—Searches for extended attributes by segment, 
including segments that exist as a child in the hierarchy

– Segment (+Exact Match)—Searches against the exact match of the 
segment

– Segment (+Hierarchical)—Searches against the hierarchy (both up and 
down) that the segment exists in

– Status—Searches for extended attribute by status

b. In the operator drop-down list, your options are determined by the choice you 
made in the first drop-down list. Choices may include:

– Null {empty field}—Searches for all extended attributes.

– Contains—Used for character searches, alphabetical, or numerical (for 
example, "Description Contains Admin" will produce only extended 
attributes with descriptions that contain the word "Admin").

– Contains All—Searches for extended attributes that contain all of the 
values you specify. This options is used for character searches, 
alphabetical, or numerical (for example, "Attribute Name Contains Color 
Coding" will produce only extended attributes with names that contain 
the words "Color Coding").
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– Contains One—Used for character searches, alphabetical, or numerical 
(for example, "Attribute ID Contains 123456" will produce only the 
extended attribute containing the ID "123456").

– Ends With—Searches for extended attributes that ends with the 
character(s) you specify

– Equals—Used to quantify search criteria entered in the field to the right 
(for example, "Attribute Name Equals Allergy" will produce only 
extended attributes with the name of Allergy).

– Is True—Searches for extended attributes matching your selection. Used 
with Most Recently Used criterion.

– Not Equals—Used to quantify search criteria entered in the field to the 
right (for example, "Attribute Name Not Equals Allergy" will produce 
only extended attributes that do not contain the name of Allergy).

– Starts With—Searches for extended attributes that start with the 
character(s) you specify

c. Use the empty search criteria field to the right of the operator drop-down list 
to qualify the selections you made above. For example, if you are searching by 
"Available In - Contains All," choose the specification type, such as 
"Equipment Specifications." All extended attributes with an available in value 
of "Equipment Attribute" are provided in the search results. You can also enter 
the percent (%) sign to perform a wildcard search matching any one character.

3. Click Search. The Search Results table displays extended attributes matching the 
search criteria. 

Setting Extended Attribute Order
The display order of extended attributes is defined using ADMN. You can set the 
display order of extended attributes by object type. The order you set also determines 
the print order of extended attributes. If no sort order is applied the system displays 
them in alphabetical order. 

To change the order of extended attributes:

1. Click ADMN > Custom Data > Extended Attribute Order. The Extended 
Attribute Order page is displayed, as Figure 3–49 shows.

Note: Click any column head to sort rows by that column head. 
Click again to reverse the order of the sort.
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Figure 3–49 Extended Attribute Order page

2. Select an object type from the Object Type drop-down list. 

3. Select an option from the Display Filters drop-down list. Options are Contains 
One (default) and Contains All.

4. Click the search icon at the end of the Display Filters field. A popup window 
displays available filters. Select desired filters, and then close the popup window. 
All extended attributes available in that object type are displayed in the Name 
column. The Status column displays the current status. 

You can change the sort order by clicking the linked column names. 

5. Click Edit.

6. In the Order column, set the order of display by assigning a number to each 
extended attribute, as Figure 3–50 shows.

Figure 3–50 Order column in edit mode

7. Click Save. 

8. To set the extended attribute order for another object type, repeat step 2 through 
step 7.
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Note: When new extended attributes are added, they are displayed 
at the bottom of this list. 
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Custom Sections
Custom sections are essentially configurable sets of extended attributes. Custom 
sections are found in the following objects:

GSM

NPD—Project, innovations/sales pipelines, strategic briefs, and activities

PQM—Issues, actions, and audits

SCRM—Companies, facilities, and sourcing approvals

eQ—Material, packaging, printed packaging, product, and trade questionnaires

The following table is an example of the type of data that can be built as a custom 
section using extended attributes:

Figure 3–51 shows the steps required to build a custom section. 

■ Activities ■ Output items

■ Equipment specifications ■ Packing configuration specifications

■ Material specifications ■ Packaging material specifications

■ Formulation specification ■ Printed packaging specifications

■ Master specifications ■ Product specifications

■ Menu item specifications ■ Smart Issue requests

■ Nutrient profiles ■ Trade specifications

Table 3–1 Data to be built as a custom section table using extended attributes

Amount Soy Hydration Factor

Min Soy Protein Isolate Numeric UOM% Extended 
Attribute

Numeric No UOM Extended 
Attribute

Min Soy Protein Concentrate Numeric UOM% Extended 
Attribute

Numeric No UOM Extended 
Attribute
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Figure 3–51 Steps for creating a custom section

Use the Custom Section Template page to build custom sections, as shown in 
Figure 3–52. 
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Figure 3–52 Custom Section Template page

Summary Section
The Summary section contains the following fields.

Section Number—A unique identifier. This field is defined by the system.

Section Name—The name of the custom section. This field is required. This value is a 
multi-lingual value. Use the set alternate language text icon to edit or add additional 
language values. This icon is not visible until the attribute is saved.

ID—A user-defined unique identifier. This field is required. This field is populated by 
the system but can be changed. This ID can be used during integration and reporting.

Hide Header—Indicates whether the header is displayed with the table. This option 
allows you to group two or more sections underneath one header. Use the order 
feature to set positions as described in "Setting Custom Section Order" on page 3-58.
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Security Classification—This field is only available if Object Level Security is enabled. 
A classification can be used to limit access to the custom section in Agile PLM for 
Process applications. For more information on Object Level Security, refer to the Agile 
Product Lifecycle Management for Process Security Configuration Guide.

Status—Click the drop-down list to assign a status to the custom section with one of 
the following:

■ New—The custom section is not yet ready to become available to Agile PLM 
for Process applications. When an custom section has a status of "New", its 
values remains editable.

■ Active—The custom section is ready to become available for use in Agile PLM 
for Process applications. 

■ Inactive—The custom section should no longer be used. Inactive custom 
sections are no longer available for assignment, however, they are not 
removed from existing objects that reference them. Inactive custom sections 
are still available for searching.

■ Archived—The custom section is not available for searching or assignment. 
Archived custom sections are not removed from existing objects that reference 
them.

Segment—Assign a segment to the custom section. This field may not display based 
on configuration settings. 

Available In—Click the link to display a selection dialog box containing a list of areas 
where you can make the custom section available. This field is required.

Tags—Tags allow you to apply special behaviors to your custom section. Multiple tags 
can be attached. Click the link to display a selection dialog box containing the 
following options:

■ Do Not Publish to Supplier—Custom section is not published to Supplier 
Portal and is unavailable in eQuestionnaire.

■ Insert Page Break - Above—Adds a page break above the custom section 
when printing.

■ Insert Page Break - Below—Adds a page break below the custom section 
when printing. 

■ Landscape Printing—Sets the custom section to print in landscape mode. This 
tag is recommended when the custom section table is wider than portrait 
printing allows. 

■ Suppress Printing—The custom section is not printable.

Category Tags—Used to categorize extended attributes and custom sections in 
understandable groupings. The categories are presented as tab groups that hold the 
extended attributes and custom sections.

Note: eQuestionnaire extended attribute availability is based on the 
related GSM specification type. For example, when creating a material 
questionnaire you are only allowed to add custom sections that are 
available in material specifications.
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De-normalization Process Section
Customers wishing to use custom section data for reporting purposes can use the 
Custom Section Denormalization process to simplify report writing and improve SQL 
query performance. The Custom Section Denormalization (CS Denorm) feature 
provides the ability to convert the complex internal data storage of custom sections 
and extended attributes into simplified data structures that can be defined in the user 
interface. 

In the Custom Section Admin user interface, users select which custom sections, rows, 
and columns to denormalize and indicate how the target database table(s) should be 
set up. The CS Denorm process then reads this information, pulls the relevant custom 
section data from specifications (or other business objects), and populates that data 
into a simplified database table(s) created solely for that custom section. 

CS Denorm uses database scripts to generate the new denormalized database tables 
for each custom section. Therefore, it requires some database administrator assistance. 
The denormalization scripts are available in the Extensibility Pack release, along with 
detailed documentation.

The De-normalization Process section allow users to specify if the custom section 
should be denormalized, how it should be denormalized, and the names of the tables 
that will be created. A custom section can be denormalized into multiple tables. This 
allows for splitting up the denormalization of very large custom sections into multiple 
target tables, and for better handling of mixed data types within columns and/or 
rows.

Figure 3–53 De-normalization Process section

The section contains the following fields:

Denorm Model—A Denorm Model represent how the custom section should be 
denormalized. Multiple denorm models can be defined, with each model resulting in a 
different database table, with different columns and rows selected for 
denormalization. The drop-down field allows you to switch between the defined 
denorm models, if any. Denorm Models are named by the Section Alias field below. 
Once a valid denorm model has been created and validated, additional denorm 
models can be created by clicking the Add New button.

Section Alias—This field determines the table name that will be used for the 
denormalized custom section table. The value must be unique across all custom 
sections, and must be no longer than a configurable number of characters (default is 
30). Click the calculate icon to pull the section name into the field replacing spaces 
with underscores. See the Agile Product Lifecycle Management for Process Custom Section 
Denormalization Guide in the Extensibility Pack for important details about field sizes.

Include in De-normalization—Check to include the custom section the in 
de-normalization process once the custom section becomes "Active."
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De-normalization Type—Determines how the custom section should be 
denormalized, for example, should the columns in the user interface directly map to 
columns in the new database table, or should the rows in the user interface be pivoted 
to columns (and columns to rows) in the new database table. Select one of the 
following:

■ Direct Map—The custom section is created as a table structure that mimics the 
view of a custom section in the UI of the application, where columns in the UI 
are mapped as columns in the database table. Using this approach requires 
that the base extended attribute data types must match for all rows (marked 
for denorm) in a column (marked for denorm). For examples, you cannot have 
a numeric extended attribute in column 1, row 1, and a date extended attribute 
in column 1, row 2. In this scenario, the Pivot de-normalization type may be 
used.

■ Pivot—This approach "pivots" a given custom section into a table structure 
where each row turns into a column and each column is represented by a row. 
Repeatable rows cannot be de-normalized using the pivot approach. Using 
this approach requires that the base extended attribute data types must match 
for all columns (marked for denorm) in a row (marked for denorm).

■ None—Prevents this section from ever being denormalized. Once a section 
has been marked with a de-normalization approach of "None," it cannot be 
changed. Note that this option is turned off by default, but can be enabled for 
all users or restricted to users in certain groups, by modifying configuration 
settings. This option would be used if you never want to run reports off of this 
custom section data.

To see the base data types of the custom section cells, click the Show/Hide Data Types 
link. This changes the custom section grid to display a color-coded base data type for 
each cell, to help plan the denormalization approach. Clicking the link again restores 
the original view. 

Figure 3–54 Show/Hide Data Types selected

Warning: If a custom section has already been de-normalized, and 
then this checkbox is unchecked, then the generated de-normalized 
custom section table will no longer be included in the data 
de-normalization process. Additionally, the next time the table 
creation process is performed this denormalized custom section table 
will be deleted from the database.

Note: When direct map or pivot is selected, it is required that you 
select at least one column and one row to include in de-normalization 
before you can save your custom section. This is in place to guarantee 
that proper data setup rules are being followed.
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De-normalization Status—Depending on the status of the custom section and 
whether the Include in De-normalization box is checked, choices are -1, 0, 1, and 2, as 
described below:

For more information on the de-normalization process, see the Agile Product Lifecycle 
Management for Process Custom Section Denormalization Guide. 

Creating a Custom Section
To create a custom section:

1. On the left navigation panel click New > Custom Sections. ADMN displays the 
Custom Section Template page, shown in Figure 3–55. 

Include in 
De-normalization 
checked?

Custom 
Section 
Status

De-Normalization 
Status Notes

No any -1: Not for 
de-normalization

The custom section is not 
de-normalized

Yes New 0: Not ready for 
de-normalization

De-normalization meta data (alias, 
etc.) is stored, but the custom section 
is ignored by the de-normalization 
scripts.

Once the custom section is made 
Active, this status is promoted to a 1.

Yes Active, 
Archived, 
Inactive

1: Ready for table 
generation

A de-normalized table can now be 
created for the custom section.

Once the table generation scripts are 
executed, the status is moved to 2: 
Ready for de-normalization.

Yes Active, 
Archived, 
Inactive

2: Ready for 
de-normalization

Custom sections in this status can 
now be picked up in the data 
de-normalization process.

Note: You can preview custom sections as you are building them by 
using the Preview feature. See "Previewing a Custom Section" on 
page 3-54 for instructions.
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Figure 3–55 New custom section

2. Define the Section Name, ID, Security Classification, Segment, Available In, and 
Tags fields in the Summary Section, as described beginning on page 3-35.

3. Define whether the custom section is included in the de-normalization process, as 
described beginning on page 3-37. 

4. Create the custom section table as described beginning in "Creating a Table" on 
page 3-41. Keep all table items (rows and columns) in the status of "New" while 
creating your table. All items can be activated at once when you activate the entire 
custom section.

5. Preview your table to make sure it is built correctly as described in "Previewing a 
Custom Section" on page 3-54.

Build your custom section as a 
table. As you add columns and 
rows, use the Preview feature to 
view your work before activating the 
custom section.
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6. In the Summary area, select "Active" in the Status field drop-down list. ADMN 
displays the following dialog box asking if you want to activate all items (rows 
and columns.)

Figure 3–56 Activate all new rows and columns dialog box 

7. Click OK.

8. Click Save & Close.

9. Flush the extended attributes/custom sections cache, as described in "Using the 
Cache Application" on page 4-3.

Creating a Table
As you create a table for your custom section, be sure to keep items in "New" status 
until you are ready to activate the entire section. Use the Preview feature as described  
on page 3-54 to check that all headings, columns, and rows are arranged as you would 
like. Activate the section only when the table is ready for use in Agile PLM for Process 
applications.

To create a table:

1. Define the column row header and add additional columns as described in 
"Creating Columns" on page 3-41. 

Figure 3–57 Custom section table

2. Add additional rows as needed as described in "Creating Rows" on page 3-45.

3. Click Save.

Creating Columns
You can add as many columns as you need in a custom section table by clicking Add 
New Column and defining the column values. Two columns are provided by default. 

This is the Row Header column
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The first (left-most) column is the Row Header column, as shown in Figure 3–57 
above. 

Defining the Row Header Column
To define the first (left most) row header column:

1. Click the lifetimes add data icon, shown in Figure 3–58, to display a Column 
Header Information dialog box, shown in Figure 3–59.

Figure 3–58 Row header

Figure 3–59 Column Header Information dialog box

2. Enter the Name of the column. The first column in a custom section can remain 
un-named. 

3. Enter the unique ID of the column.

4. Enter the display width of the column in the UI Width field. This is the width of 
the column in the user interface. 

 

Note: Certain UI elements require a minimum space to display 
properly. If you are referencing a single or multi-select style extended 
attribute, the UI width must be as wide as your longest selectable 
item.
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5. Enter the print width of the column in the Print Width field. This is the width of 
the column when the custom section is printed. If a print width is not provided, 
the printed custom section will be unreadable. 

6. Click the search icon at the end of the Tags field to select the tags (if any) to assign 
to this column. Tags allow you to apply special behaviors to your column. 
Multiple tags can be attached. Click the link to display a selection dialog box 
containing the following options:

■ Do Not Publish to Supplier—This column will not be published to Supplier 
Portal and will be unavailable in eQuestionnaire.

■ Suppress Printing—This column will not be included when printing the 
custom section.

■ Supplier eQ - Create—Allows the supplier to add or remove these columns in 
a questionnaire.

7. Click Done to confirm your choices.

Defining Additional Columns
To define additional columns:

1. Click Add New Column to add an additional column to the table. The Column 
Header Information dialog box is displayed, as Figure 3–60 shows. If you are 
defining a column that already exists, click the add data icon to display the 
Column Header Information dialog box.

Figure 3–60 Column Header Information dialog box

2. Enter the Name of the column.
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3. Enter the unique ID of the column. This field is automatically numbered by the 
system but can be modified. This field has to be unique within the custom section 
set of columns. This ID can be used when using cell location awareness in 
calculated extended attributes.

4. Set the column Status by selecting a status from the drop-down list. Keep the 
status of the column set to "New" until your entire section and/or column is ready 
to be activated.

5. Enter the display width of the column in the UI Width field. This is the width of 
the column in the user interface. 

 

6. Enter the print width of the column in the Print Width field. This is the width of 
the column when the custom section is printed. If a print width is not provided, 
the printed custom section will be unreadable. 

7. Click the search icon at the end of the Tags field to select the tags (if any) to assign 
to this column. Tags allow you to apply special behaviors to your column. 
Multiple tags can be attached. Click the link to display a selection dialog box 
containing the following options:

■ Do Not Publish to Supplier—This column is not published to Supplier Portal 
and is unavailable in eQuestionnaire.

■ Supplier eQ - Create—Allows the supplier to add or remove these columns in 
a questionnaire.

■ Suppress Printing—This column is not included when printing the custom 
section.

8. Check the Add this item when section is created box to automatically add this 
column to the table when the section is created by the user. 

9. To include the column in the de-normalization process for the given denorm 
model, select the Include in De-normalization checkbox.

10. Enter a unique name in the De-normalization Alias field, or click the calculate 
action icon to auto-generate one.

11. Click Done to confirm your choices. Figure 3–62 shows the defined columns.

Note: Certain UI elements require a minimum space to display 
properly. If you are referencing a single or multi-select style extended 
attribute, the UI width must be as wide as the longest selectable item.

Note: When columns are in a "New" status they can be deleted. To 
delete a column, select the red Delete link.
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Figure 3–61 Defined columns

Creating Rows
You can add as many rows as you need in a custom section table. 

Defining Additional Rows
To add a new row:

1. Click Add New Row to add an additional row to the table. The Row Header 
Information dialog box is displayed, as Figure 3–62 shows. If you are defining a 
row that already exists, click the edit icon to make the row editable. Click the add 
data icon to display the Row Header Information dialog box.

Figure 3–62 Adding a new row
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2. Enter a name for the row in the Name field.

3. Enter a unique identifier in the ID field. This field is automatically numbered by 
the system but can be modified. This field has to be unique within the custom 
section set of rows. This ID can be used when using cell location awareness in 
calculated extended attributes.

4. Set the row Status by selecting a status from the drop-down list. Keep the status of 
the row set to "New" until your entire section and/or row is ready to be activated. 

5. Click the search icon at the end of the Tags field to select the tags (if any) to assign 
to this row. Tags allow you to apply special behaviors to your row. Multiple tags 
can be attached. Click the link to display a selection dialog box containing the 
following options:

■ Do Not Publish to Supplier—This row is not published to Supplier Portal 
and is unavailable in eQuestionnaire.

■ Hide Header—The header for this row is not displayed in consumption or 
printing. When all visible rows in a custom section include the hide header 
tag, the entire header column does not appear. This tag is beneficial when 
using repeatable rows. See "Formatting Custom Sections" on page 3-50 for an 
example of what a custom section looks like leveraging this tag. 

■ Repeatable—This row template can be re-used during consumption. This tag 
should only be used when the use case is absolutely necessary. It is 
recommended to use distinct rows containing distinct attributes. For more 
information, see "Re-using a Custom Section Row Template" on page 3-52.

■ Supplier eQ - Create—Allows the supplier to add or remove these rows in a 
questionnaire.

■ Suppress Printing—This row is not included when printing the custom 
section.

6. Check the Add this item when section is created box to automatically add this 
row to the table when the section is created by the user.

7. Check the Create copies of this row box to add one or more copies of this row to 
the table; enter the number of rows to create in the # of Copies text field. This 
feature is better used when all cells have already been defined. Refer to "Copying 
Rows" on page 3-47. 

8. To include the column in the de-normalization process for the given denorm 
model, select the Include in De-normalization checkbox.

9. Enter a unique name in the De-normalization Alias field, or click the calculate 
action icon to auto-generate one.

10. Click Done to confirm your choices. Figure 3–63 shows the newly created row in 
edit mode. You can now define the cells.

Figure 3–63 Added row
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Defining Cells
Custom section cells contain extended attributes.

To define a cell in a table:

1. Click the edit icon to make the row or column editable.

2. In the cell that you are adding an attribute to, click the add data icon to display the 
Extended Attribute dialog box. This list contains extended attributes that have 
been marked with a class of "Custom Sections" and have an "Active" status.

3. Select an extended attribute from the list. For more information on creating 
extended attributes, refer to "Creating an Extended Attribute" on page 3-27.

4. Click Done to confirm your choice. 

5. Continue this process until all cells in the row contain an extended attribute.

6. Click the apply changes icon to apply your changes.

Figure 3–64 Defined cells

Copying Rows
To copy an existing row: 

1. Click the edit icon of the row you would like to copy. This makes the row editable.

Note: When you add an extended attribute to the cell, a clear field 
icon is displayed to the right of the selection. You can click this icon to 
delete the extended attribute from the table, as long as the statuses of 
the associated row/column are "New."

Warning: Cells cannot be edited once the row or column has been 
activated.

Note: The extended attribute’s Attribute ID value is displayed in 
brackets after the extended attribute name. 

Clicking a cell with an extended attribute launches a read-only popup 
displaying the extended attribute information.



Creating a Custom Section

3-48 Agile Product Lifecycle Management for Process Administrator User Guide

2. In the Row Header column, click the add data icon to display the Row Header 
Information dialog box.

3. Check the Create copies of this row box to add one or more copies of this row to 
the table. The # of Copies field appears.

4. Enter the number of rows to create in the # of Copies field. Figure 3–65 shows 
these entries.

Figure 3–65 Copying row fields

5. Click Done. The table displays the copied rows. A dialog box displays asking if 
you want to proceed with the copy.

6. Click OK. The new row(s) display under the copied row.

7. Define each row following the procedure above.

Reordering Columns
The order the columns appear in during consumption is set through the custom 
section template. 

To reorder the columns in your table:

1. With the page in edit mode, click Reorder Columns. A dialog box is displayed, as 
Figure 3–66 shows.
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Figure 3–66 Reorder columns dialog box

2. Click a column value in the list, and then click Move Up or Move Down to set the 
desired position.

3. Repeat step 2 as needed to move other columns to the desired position. 

4. Click Done. 

Reordering Rows
The order the rows appear in during consumption is set through the custom section 
template. 

To reorder the rows in your table:

1. With the page in edit mode, click Reorder Rows. A dialog box is displayed, as 
Figure 3–67 shows. 

Figure 3–67 Reorder rows dialog box

2. Click a row value in the list, and then click Move Up or Move Down to set the 
desired position.

3. Repeat step 2 as needed to move other rows to the desired position.
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4. Click Done.

Legend  

Rows and columns are colored to represent status and whether an item is default. The 
following legend is provided.

Figure 3–68 Custom Section statuses

See "Status" on page 3-36 for more information on statuses. De-normalization icons are 
defined below:

 —The Include in De-normalization icon is displayed if both the column and row 
for that cell are marked as Include In De-normalization, but their statuses are not 
Ready For Denormalization (meaning those columns and rows have not been created 
in the new de-normalization table.)

 —The De-normalized icon displays when both the column and row have been 
created in the denormalized table.

Formatting Custom Sections
You now have some formatting options when working with custom data.

Hide Row Header  Depending on your use case and searching needs, you may not feel 
the need to repeat the row header over and over again throughout the section. You can 
add the "hide header" tag to the repeatable row's Row Header Information dialog box 
to accomplish this as described on page 3-46. Figure 3–69 and Figure 3–70 show what a 
custom section looks like before and after Hide Header tag is applied.

Figure 3–69 Custom section displaying row headers

Figure 3–70 Same section leveraging the hide header tag

This tag can be used on all row types, repeatable and none repeatable. When all rows 
of a custom section contain the Hide Header tag the entire row header column is 
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hidden. If only a few rows out of the set have the Hide Header tag the bold text in the 
cell is hidden on those rows.

Hide Custom Section Header  Depending on your use case and searching needs, you may 
want to display multiple sections under one header. When a column contains this tag 
the header text is hidden when the custom section is being consumed in GSM, SCRM, 
PQM, eQ, etc. This header does not print. 

To create a section with a hidden header:

1. Create the custom sections following the same steps as outlined beginning on 
page 3-41.

2. Select the Hide Header checkbox on the Custom Section template as shown in the 
following figure:

Figure 3–71 Hide Header checkbox

3. Make sure to adjust the display order of the custom sections so they display 
appropriately using the Custom Section Order tool, as shown below. 

Note: Error messages and advanced custom section searching still 
leverage the row header name.
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Figure 3–72 Custom Section order tool

Re-using a Custom Section Row Template
You can re-use a custom section row template using the "Repeatable" tag. 

Use Case Example
The simplest of use cases this solution is addressing revolves around a qualitative list 
of 1500 possible flavors. At most a section could contain 50 flavors; previously a 
custom section administrator would have to create 50 row templates with ambiguous 
row header names: Flavor 1, Flavor 2, Flavor 3, and so on. When consumed these 
identifiers make it unusable when searching, because the row header has to be 
identified. Alternatively the administrator would be required to create 1500 row 
templates for the custom section; this was unreasonable and depending on the number 
of rows needed, unsupported.

Note: Remember that if users are using the Advanced custom data 
search method they need to reference the name of the section with the 
hidden header. So the name of the section must be very descriptive. 
These values can also be searched using the quick method where the 
section name is not needed.

Important: This feature should be used only when absolutely 
necessary and is not intended as a quick custom section creation tool. 
It is still our recommendation to use distinct custom section rows and 
extended attributes whenever possible. Using distinct rows and 
extended attributes allows for better performing reporting, integration 
and searching. 
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The Solution
The ability to re-use a custom section row template provides a possible solution. Now 
the administrator just needs to create one row called "Flavor" and include the 
qualitative single select extended attribute as the first cell of that row. 

To create a repeatable row:

1. Create a custom section as described in "Creating a Custom Section" on page 3-39.

2. For the row you would like to be repeatable to the end user, add the tag of 
"Repeatable" to the row header information as shown in the following figure:

Figure 3–73 Repeatable tag 

Figure 3–74 shows what this custom section could look like in consumption:

Note: Because the row is repeated on the specification, distinct 
extended attributes cannot be used within the row. 
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Figure 3–74 Custom section containing repeatable row

Previewing a Custom Section
Preview custom sections by clicking Preview at the bottom of the page. You can use 
this feature to view the section as the user would see it. The preview includes all items 
in the status of "Active" and "New." If you don’t wish to include "New" items, uncheck 
the Include all "New" items box. Preview mode allows you to mimic the user’s 
experience. Preview also allows you to see UI column widths. 

Figure 3–75 Custom Section page, Preview button

When you click Preview, the current custom section, including default values, is 
displayed in a dialog box, as Figure 3–76 shows.

Figure 3–76 Custom Section in preview mode

To make further changes to the custom section, click Close. Agile PLM for Process 
closes the preview dialog box closes and returns to the Custom Section page. 

Calculating Extended Attributes
While in preview mode, you can click the Calculate button to calculate extended 
attribute values. This button works only with calculate attributes that are referencing 
attributes present in the previewed section. Depending on your calculated extended 
attributes, the system may pull in the mock values for items referenced by ID. Refer to 
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the "Calculated Attributes" section of the Agile Product Lifecycle Management for Process 
Extensibility Guide for more information. 

Editing Custom Sections
To edit a custom section:

1. Click ADMN > Custom Data > Custom Sections.

2. Using the search feature, search for the custom section to edit. (For instructions on 
the search feature, see "Searching for Custom Sections" on page 3-57.)

3. Click Edit.

4. Edit custom section summary information, as described in "Summary Section" on 
page 3-35.

5. To edit the table, complete the procedures referenced below:

■ "Creating Columns" on page 3-41

■ "Defining the Row Header Column" on page 3-42

■ "Defining Additional Columns" on page 3-43

■ "Creating Rows" on page 3-45

■ "Defining Additional Rows" on page 3-45

■ "Defining Cells" on page 3-47

■ "Copying Rows" on page 3-47

■ "Reordering Columns" on page 3-48

■ "Reordering Rows" on page 3-49

6. Activate all new rows and/or columns.

7. Click Save & Close.

8. Flush the extended attributes / custom sections cache, as described in "Using the 
Cache Application" on page 4-3.

Copying a Custom Section
To copy a custom section:

1. Click ADMN > Custom Data > Manage Custom Sections. 

2. Use the search feature to select the custom section to copy. Figure 3–77 shows an 
existing custom section.
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Figure 3–77 Custom section with Copy button

3. Click Copy. (This button does not appear if the page is in edit mode.) All items for 
the custom section are copied over to a new page, including rows, column, and 
cells.

4. Define the Section Name, ID, Hide Header, Security Classification, Available In, 
and Tags fields in the Summary Section, as described beginning  on page 3-35.

5. Define the fields in the De-normalization Process section, as described beginning  
on page 3-37. 

6. Edit the custom section table as described in "Editing Custom Sections" on 
page 3-55.

7. Preview your table to make sure it is built correctly as described in "Previewing a 
Custom Section" on page 3-54.

8. In the Summary area, select "Active" in the Status drop-down list. ADMN displays 
the following dialog box asking if you want to activate all items (rows and 
columns.)

Figure 3–78 Activate all new rows and columns dialog box

9. Click OK.

10. Click Save & Close.

11. Flush the extended attributes / custom sections cache, as described in See "Using 
the Cache Application" on page 4-3.
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Searching for Custom Sections
To search for custom sections:

1. Click ADMN > Custom Data > Custom Sections. The Custom Section Template 
Search page displays.

2. Enter search criteria for custom sections using a combination of three search fields:

a. In the key field drop-down list, select your search criteria as follows:

– -- —Searches for all custom sections

– Category Tab—Searches by category tab

– Column Name—Searches by column name

– Created—Searches by creation date

– Last Edit—Searches by last edit date

– Most Recently Used—Searches for custom sections most recently used

– Row Name—Searches by row name

– Segment (+Children)—Searches for custom sections by segment, 
including segments that exist as a child in the hierarchy

– Segment (+Exact Match)—Searches against the exact match of the 
segment

– Segment (+Hierarchical)—Searches against the hierarchy (both up and 
down) that the segment exists in

– Section ID—Searches by section identifier

– Section Name—Searches by section name

– Security Classification—Searches by security classification.

– Status—Searches by status

b. In the operator drop-down list, your options are determined by the choice you 
made in the key field drop-down list. Choices may include:

– Contains—Used for character searches, alphabetical, or numerical (for 
example, "Column Name Contains Admin" will produce only custom 
sections containing a column name of "Admin").

– Equals—Used to quantify search criteria entered in the field to the right 
(for example, "Section ID Equals 123456" will produce only the custom 
section with the section ID of "123456").

– Greater Than—Searches for custom sections with a value greater than a 
value you specify (for example "Last Edit Greater Than 8/1/09" will 
produce only custom sections edited after "8/1/09").

– Is True—Used only with the Most Recently Used criterion and allows you 
to find your most recently viewed custom sections.

– Less Than—Searches for custom sections with a value less than a value 
you specify (for example "Created Less Than 1/1/09" will produce only 
custom sections created before "1/1/09"). 

– Starts With—Searches for custom sections that start with the character(s) 
you specify
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c. Use the empty search criteria field to the right of the operator drop-down list 
to qualify the selections you made above. You can also enter the percent (%) 
sign to perform a wildcard search matching any one character.

3. Click Search. The Search Results table displays custom sections matching the 
search criteria. 

Setting Custom Section Order
The display order of custom sections is defined using ADMN. You can set the display 
order of custom sections by object type. The order you set also determines the print 
order of custom sections. If no sort order is applied, the system displays them in 
alphabetical order. 

To change the order of custom sections:

1. Click ADMN > Custom Data > Custom Section Order. The Custom Section Order 
page is displayed, as Figure 3–79 shows.

Figure 3–79 Custom Section Order page

2. Select an object type from the Object Type drop-down list. All custom sections 
available in that object type are displayed in the Name column. The Status column 
displays the current status. 

3. If needed, use the Display Filters selection to view only the new and active custom 
sections. You can change the sort order by clicking the linked column names. 

4. Click Edit.

5. In the Order column, set the order of display by assigning a number to each 
custom section, as Figure 3–80 shows.
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Figure 3–80 Order column in edit mode

6. Click Save. 

7. To set the custom section order for another object type, repeat step 2 through step 
7.

 

Note: When new custom sections are added, they are displayed at 
the bottom of this list. 
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4Using CACHE to Manage Caches

This chapter explains the cache management feature. Topics in this chapter include:

■ Scheduling Data Cache Flushes

■ Using the Cache Application

Scheduling Data Cache Flushes
Caches are temporary storage areas for frequently or recently accessed data. Caches 
must be routinely flushed. Modified data that belongs to one process must be written 
out of the cache to main memory so that the cache can be used by another process.

The CACHE (Manage Data Caches) application provides administrators with an 
application for managing data caches. You can access the CACHE application on the 
left navigation panel. For more information see "Using the Cache Application" on 
page 4-3. 

You should flush caches after the following activities:

■ After creating/editing/importing users using the UGM application

■ After creating/editing/importing groups using the UGM application

■ After creating/editing/importing workflows using the WFA application

■ After creating/editing data using the ADMN application

■ After creating/editing core data using the ADMN application

Workflow Groups and Workflows
When creating workflow groups and workflows, flush the cache after you have 
completed each of the following steps:

■ After creating/editing workflow groups in UGM

■ When creating workflow groups in UGM, after adding or changing assigned roles 
to the groups

■ After creating workflows in WFA

Warning: When creating new workflow groups in UGM, be sure to 
flush the cache before adding new users to the group to avoid 
encountering system issues.
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■ Before exporting workflows or workflow groups from the staging environment to 
the production environment

■ After importing workflows or workflow groups into the production environment 
from the staging environment

Data Administration
When working in the ADMN (Manage Core Data) application, flush the cache after 
you have created/edited any data using the ADMN application. You must also flush 
the cache from the production environment after you have exported completed data 
changes from a staging environment to a production environment.

For example, flush the cache as follows:

■ After creating/editing extended attribute groups

■ After creating/editing extended attributes

■ After creating/editing sections (customer-specific data)

■ After creating/editing taxonomies

■ After creating/editing any core data
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Using the Cache Application
Access the CACHE application by selecting CACHE from the left navigation panel. By 
default, CACHE displays the Schedule Cache Flush page, as Figure 4–1 shows.

Figure 4–1 Schedule Cache Flush page

The Select Cache Group drop-down list contains several cache flush selections:

■ Taxonomy—Select this option to flush the taxonomy cache after you have made 
changes to any tree lists/taxonomies using the ADMN (Manage Core Data) 
application.

■ Portal Application Cache Group—Select this option to flush the data cache after 
you have made changes to the data within the Data Administration (ADMN) 
application.

■ Workflow Cache Group—Select this option to flush the workflow cache after you 
have made workflow changes using the WFA (Workflow Administration) 
application.

■ User Cache Group—Select this option to flush the user/group cache after you 
have made user/group changes using the UGM (User Group Management) 
application.



Using the Cache Application

4-4 Agile Product Lifecycle Management for Process Administrator User Guide

■ Admin Data Cache Group—Select this option to flush the administrator data 
cache after you have made core data changes using the ADMN (Manage Core 
Data) application. This option is used for all ADMN data changes other than 
taxonomies, extended attributes, and custom sections. These data types have their 
own cache flush groups.

■ Extended Attributes / Custom Sections—Select this option to flush the extended 
attributes/ sections cache after you have made extended attribute/ section 
changes using the ADMN (Manage Core Data) application.

After you have selected a cache group from the drop-down list, use the Select a Date 
and Time feature to schedule your cache flush. 

When you have made your selection, click Schedule Cache Flush.

Scheduled Cache Flush Queue
This section displays a queue showing scheduled cache flushes has been added. The 
queue shows which applications have been flushed, and indicates whether each 
execution was successful.
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5Using Performance Logging

This chapter explains the performance logging feature. Topics in this chapter include:

■ Overview

■ Enabling Performance Logging

■ Performance Log File

■ Performance Analysis

Overview
Performance Logging is a feature that helps troubleshoot performance issues. When 
enabled, a .csv file will be created on the server with detailed performance information 
about activities performed on the system. When this feature is enabled, there is little 
impact to the user's experience, however, we recommend only enabling it while 
troubleshooting. 

Enabling Performance Logging
By default Performance Logging is disabled. Follow these steps to enable performance 
logging:

1. Assign the [PERFORMANCE_ADMIN] role to a group of users designated as 
performance administrators. Follow your normal UGM process for assigning the 
new role, including export and import, if necessary. Refer to the Agile Product 
Lifecycle Management for Process User Group Management User Guide for instructions. 

2. With the admin user that has the above role, login to PLM for Process. If already 
logged in, then logout and re-login to have the new role respected. Open the 
Performance Admin UI by navigating to the Performance Admin menu item from 
the portal navigation, as Figure 5–1 shows below.



Performance Log File

5-2 Agile Product Lifecycle Management for Process Administrator User Guide

Figure 5–1 Menu navigation

3. In the Performance Admin dialog box, set the Enabled Flag to "True". 

Refer to the Agile Product Lifecycle Management for Process Configuration Guide for more 
details on performance logging configurations.

Performance Log File
The location of the performance log file can be configured on the Performance Admin 
UI by setting the Log File Path field. The default is "%PRODIKA_HOME%\\Logs\\". 

The name of the performance log file is "PLM4P_Performance_Log_0".csv. When 
the file reaches a certain size or if the file is locked, preventing it from being written to, 
another log file is created with the "0" incremented.

Performance Analysis

Logging the Action
If an area of the application has been identified as poor performing, for example, slow 
response time, then Performance Logging should be used to capture the execution 
detail. If possible, isolate the use case to a single user performing a single UI action. 
For example, save a specification. 

To log the action detail, follow these steps: 

1. Make sure Performance Logging is turned on and test that the log file is being 
written to. 
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2. Have a user navigate to the location in the application just prior to the user action 
that will be analyzed. 

3. Wait until the performance log file is updated. The frequency in which this file is 
updated is configured in the Admin UI with the Log Frequency (in seconds): 
field. The default is 30 seconds.

4. Delete the performance log file.

5. Have the user perform the action.

6. Wait until the log file is updated. 

7. Create a copy of the log file. Do NOT open this file directly as this will lock the file.

8. Open the copied file with an appropriate application such as Microsoft Excel.

9. Check to see if the action the user performed was captured. This can be 
accomplished by looking at the first column in the file called Root Event. If you 
are uncertain, then wait another 30 seconds and copy the file once again and open 
it.

Interpreting the Data
Most of the data in the log file is intended to be analyzed by an Agile PLM for Process 
developer, though customers can use this data to determine if any SQL is executing 
slowly. To analyze SQL, see the "Finding SQL Performance Issues" section below.  

The other area that can be used by the customer is for capturing the execution of 
custom code. Most extensibility points have a line in the log file that represents this 
custom code. There is a lot of data in the log file and the explanation is beyond the 
scope of this document, so to keep it simple just look at the columns titled Event Type 
and DurationInMilliseconds. This information tells you how long that item took, in 
milliseconds.

If you want Oracle to investigate the issue in more detail, please go through Oracle 
Support and upload the spreadsheet to a service request.

Finding SQL Performance Issues
Poor performance can often be attributed to poor performing SQL. The execution time 
for SQL depends on many factors such as, network traffic and bandwidth, amount of 
data retrieved, amount of data in the database tables and hardware specifications. 
Sometimes execution time of SQL can be improved by the addition of indexes. Because 
the need for indexes is specific to the customers’ implementation, it is their 
responsibility to ensure the proper indexes are present. Oracle provides some 
out-of-the box indexes that are useful to the majority of customers but additional 
indexes should be created by the customer. Performance Logging is a tool that can 
simplify the identification of inefficient SQL.

Much of the SQL executed by the application is captured in the log file on lines that 
have "SQL" in the Event Type column. The DurationInMilliseconds column shows 
the time in milliseconds, taken to execute the SQL. The Details column displays the 
actual SQL executed. This column should be looked at to find any potential SQL 
issues. This assumes the network between the PLM for Process web/application 
server and the database server is not an issue. 

First it is easiest to find any single SQL statement that exceeds an acceptable duration 
threshold. This threshold varies between implementations. A general rule of thumb is 
to investigate anything over 200ms. 
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Next it would be useful to look at all similar SQL statements where the combined time 
is large.

Once all the SQL statements are identified as a potential issue, a database 
administrator should do further analysis to determine if the addition of indexes might 
help. Note that adding indexes can drastically help performance, but adding too many 
unnecessary ones could hurt performance. Retesting after the indexes are added 
should be performed to ensure the addition produces the desired improvements.

User Interface and Field Definitions
Figure 5–2 below shows the Performance Admin user interface.

Figure 5–2 Performance Admin page

The Performance Admin page contains the following fields:

■ Enabled—Indicates whether or not the performance logger is enabled. It only 
logs data when set to "True".

■ Log File Path—The directory path to the location of the log file.

■ Log Frequency (in seconds)—The frequency in which the logger writes to the 
log file.

■ Sample Rate—If it is desired that user activity in general should be logged 
without targeting an identified area that needs improvements, it is likely that 
not every user action needs to be logged and instead a sampling can be 
logged. The Sample Rate determines at what interval to capture the user’s 
actions. For example, when set to 0 or 1 every action is logged. When set to 2 
every 2nd action is logged and the others are ignored. When set to 3 every 3rd 
action is logged, and so on. This allows for less of a performance impact and 
less data captured.

■ Default Rollup —Rollup can be used to combine all events of the same name 
and parent, onto one line instead of multiple lines in the log file. The 
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Occurrences column shows the number of times the event was executed. This 
helps reduce the size of the log file.

This value is the default value for all event types and can be configured 
individually for each event in the event grid.

■ Default Duration Filter (in milliseconds)—Duration Filter can be used to 
filter out events (lines in the log file, not user actions) that do not take longer 
than a given duration threshold. For instance if you are not interested in 
seeing any event that takes under 50ms, then set this field to 50. Only events 
with a duration of greater than 50 are shown. This help s reduce the size of the 
log file.

This value is the default value for all event types and can be configured 
individually for each event in the event grid. A value of -1 in the Duration 
Filter of the individual event indicates that the default should be used.
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AInFoods IDs and ISO Codes

Topics in this appendix include:

■ InFoods IDs

■ ISO Codes

InFoods IDs
The following InFoods IDs are currently available in GSM for use in calculated 
attributes.

Table A–1 InFoods IDs 

Name InFoods ID UNID Sequence ID

ALCOHOL ALC ALC 520

AOAC Fiber FIBTG FIBTG 60

ASH ASH ASH 210

CALCIUM CA CA 350

CALORIES ENERC_KCAL ENERC_KCAL 10

CARBOHYDRATES CHOCDF CHOCDF 40

CARBOHYDRATES (AVAILABLE) CHOAVL CHOAVL 45

CAROTENE CARTB CARTB 490

CASEIN (Nx6.38) CASN CASN 34

CHLORIDE CLD CLD 354

CHOLESTEROL CHOLE CHOLE 190

CHOLINE CHOLN CHOLN 435

CHOLINE CHLORIDE CHOLNCLD CHOLNCLD 440

CHROMIUM CR CR 357

COBALAMIN-B12 VITB12 VITB12 280

COPPER CU CU 450

d-BIOTIN BIOT BIOT 430

DIETARY FIBER FIBTS FIBTS 50

Energy kJ ENERC_KJ ENERC_KJ 20



InFoods IDs

A-2 Agile Product Lifecycle Management for Process Administrator User Guide

FOLIC ACID FOLAC FOLAC 320

FRUCTOSE FRUS FRUS 530

GLUCOSE GLUS GLUS 85

IODINE ID ID 360

IRON FE FE 370

LACTOSE LACS LACS 97

LYCOPENE LYCPN LYCPN 540

MAGNESIUM MG MG 380

MALTOSE MALS MALS 94

MANGANESE MN MN 480

MOISTURE WATER WATER 200

MOLYBDENUM MO MO 485

MONOUNSATURATED FAT FAMS FAMS 140

NIACIN-B3 NIA NIA 250

POTENTIAL NIACIN NIAEQ NIAEQ 260

NITROGEN NAM NAM 500

OLIGOSACCHARIDES OLSAC OLSAC 65

OMEGA-3 F18D3N3 F18D3NS 160

OMEGA-6 F18D3N6 F18D3N6 170

ORGANIC ACIDS ORGACD ORGACD 110

PANTHOTHENIC PANTAC PANTAC 340

PHOSPHORUS P P 390

POLYOLS POLYOLS POLYOLS 215

POLYUNSATURATED FAT FAPU FAPU 150

POTASSIUM K K 400

PROTEIN PROCNT PROCNT 30

PROTEIN (Nx6.25) PROCNT_NX625 PROCNTx625 32

Pyridoxine - B6 VITB6A VITB6A 270

Riboflavin - B2 RIBF RIBF 240

SATURATED FAT FASAT FASAT 130

SELENIUM SE SE 460

SODIUM NA NA 410

STARCH STARCH STARCH 510

SUCROSE SUCS SUCS 92

Sugars: Di SUGARDI SUGARDI 90

Sugars: Mono SUGARMO SUGARMO 80

Table A–1 InFoods IDs 

Name InFoods ID UNID Sequence ID
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Sugars: Other SUGARM SUGARM 100

TAURINE TAU TAU 470

Thiamin - B1 THIA THIA 230

TOTAL FAT FAT FAT 120

TOTAL SOLIDS TTLSOLID TTLSOLID 205

TOTAL SUGAR SUGAR SUGAR 70

TRANS FATTY ACID FATRN FATRN 180

Vitamin A - IU VITA_IU VITA_IU 223

Vitamin A - Total VITA- VITA- 220

VITAMIN C VITC VITC 290

VITAMIN D VITD- VITD- 300

VITAMIN E VITE VITE 310

VITAMIN K VITK VITK 330

WHEY (NX6.38) WHEY WHEY 37

ZINC ZN ZN 420

Table A–1 InFoods IDs 

Name InFoods ID UNID Sequence ID
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ISO Codes
The following ISO codes are currently available in GSM for use in calculated 
attributes.

Table A–2 ISO codes for units of measure 

Name Abbreviation Id ISO Code

#/SQ.FT. #/SQ.FT LB-SQ.FT FP

CELSIUS C C CE

CENTILITER cL CENT-L C3

CENTIMETERS cm CENTI-M CM

COUNT Cnt COUNT 1N

CUBIC CENTIMETERS Cu. cm CU. CM CC

CUBIC FEET Cu. Ft CU. FT CF

CUBIC INCHES Cu. In. CU.IN CI

CUBIC METER m3 CU.M CR

DAYS days DAYS DA

DECILITER dL DECI-L DL

DEGREES Degrees DEGREES DD

FAHRENHEIT F F FA

FEET ft ft FT

FLUID OUNCES (UK) fl oz (UK) FL-OZ-UK FZ

FLUID OUNCES (US) fl oz (US) FL-OZ-US FO

GALLONS (UK) gal (UK) GAL-UK GI

GALLONS (US) gal (US) GAL-US GA

GRAMS g G GR

HOURS hr HR HR

INCHES in IN IN

INTERNATIONAL UNITS IU IU F2

KILOGRAMS kg KILO-G KG

KILOLITERS kL KILO-L K6

KIT LEVEL Kit Level KITLEVEL KT

LITERS L LITER LT

METERS m M MR

MICROGRAMS ug MICRO-G MC

MILLIGRAMS mg MILI-G ME

MILLILITERS mL MILI-L ML

MILLIMETERS mm MILI-M MM

MINUTES min MIN MJ

MONTHS mos MONTHS MO
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OUNCES oz OZ OZ

PARTS PER MILLION ppm PPM 59

PARTS PER THOUSAND per mil PPTH NX

PERCENT % PERCENT P1

POUNDS lb LB LB

POUNDS PER SQUARE INCH PSI PSI PS

SECONDS s SEC 3

SQUARE INCHES Sq. In. SQ.IN SI

UNITS units UNITS UN

WEEKS wks WEEKS WK

YEARS yrs YEARS YR

Table A–2 ISO codes for units of measure 

Name Abbreviation Id ISO Code
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